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ABSTRACT 
 

Tumor heterogeneity resulting from the co-existence of phenotypically diverse tumor cell 

populations is a major contributor in the pathogenesis of several human malignancies. In addition 

to the steady acquisition of heritable molecular changes during cancer progression, cellular 

plasticity contributes to phenotypic modifications that often allow cells to sustain both a 

migratory and proliferative character. A critical example of cell plasticity is the epithelial-to-

mesenchymal transition (EMT) where cancer cells convert across a spectrum of epithelial and 

mesenchymal cellular identities. Multiple distinct EMT states have been described and their 

associated regulatory mechanisms have begun to be defined. Such is the case of the trailblazer 

and opportunist EMT states. Trailblazer EMT activation confers cells with ability to extend 

cellular protrusions, which reorganize the ECM into paths that facilitate invasion. Importantly, 

the paths created by trailblazer cells promote the invasion of siblings in an opportunist EMT 

state, which confers cells with migratory ability, but not the capacity to independently initiate 

invasion. Notably, this relationship permits opportunist cells to convert from a benign to a 

malignant invasive state.  

The data presented here suggests that cell-intrinsic properties influence the response to 

extrinsic EMT-inducing factors and the acquisition of trailblazer cell features. Specifically, our 

findings reveal that the intrinsic expression of the AP-1 family member Fra1 is required for the 

induction of a trailblazer EMT by TGFb. Moreover, we uncovered that the TGFb and EGFR-
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ERK1/2-Fra1 signaling pathways activate distinct regulatory networks that increase collective 

invasion. Importantly, Fra1 primes cancer cells to rapidly invade in response to TGFb  while 

retaining epithelial traits. Given these observations, I propose that Fra1 is a priming factor that 

allows cells to respond to TGFb, undergo a trailblazer EMT and lead collective invasion. 

Therefore, integration of parallel signaling programs dictates the mode of invasion, promoting 

increased cancer cell heterogeneity in basal-like breast tumors.  
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CHAPTER I: INTRODUCTION 

Metastasis  

Metastatic growth accounts for more than ninety percent of cancer related deaths arising 

from solid tumors, including tumors of the breast [1].  Metastasis is a stepwise process that 

involves local invasion, systemic dissemination and colonization of new tissues [2]. Epigenetic 

and genetic perturbations [3] as well as paracrine signals from the microenvironment [2] confer 

tumor cells with the ability to enzymatically degrade basement membrane and invade into the 

surrounding parenchyma [4, 5]. In addition, non-tumor cells such as fibroblasts and macrophages 

can degrade the basement membrane and allow the invasion of tumor cells [2]. The induction of 

invasion is a key event because tumor cells in the connective tissue have the access to blood and 

lymphatic vessels, which provide a means of dispersion to new locations in the body  [6, 7].  

Tumor cells enter blood and lymphatic vessels through a process called intravasation. During 

intravasation, cancer cells alter endothelial cell permeability by secreting factors such as VEGF 

and the proteolysis of endothelial cell-cell adhesions [8, 9]. Recruited immune cells can also 

promote disruptions in vessel integrity that facilitate intravasation  [8, 9]. Only a fraction of 

cancer cells survive in circulation [10]. While the mechanisms that permit the survival of cells 

during the transit from the primary site to a distant organ remain unclear, it is believed that 

circulating tumor cell (CTC) clusters that detach from collectively invading cell cohorts provide 

protection from shear forces, immune attack, and anoikis [11, 12]. Tumor cells exit the 

circulatory system through a process called extravasation. During extravasation, the surviving 

cells employ similar mechanisms of endothelial cell remodeling and stromal cell recruitment to 

breach the walls of blood vessels and invade into a secondary organ [13, 14]. Colonization 
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occurs when tumor cells proliferate at a distant site, culminating in a secondary malignant 

growth [15].  

Regulation of tumor cell phenotype 

Metastasis is induced by changes in the functional properties of tumor cells during tumor 

evolution [2]. Alterations in tumor cell traits are brought about by genetic and epigenetic 

alterations caused by the genomic instability that accompanies deregulated cell growth [16, 17]. 

In addition to the heritable changes that continue to appear and accumulate over disease 

progression, extracellular stimuli can also drive tumor cell diversity. Cues from the 

microenvironment such as the ones resulting from immune and stromal cell interactions may 

induce transcriptional programs that can modify a cell’s phenotype without altering its genome 

[18, 19], also known as phenotypic plasticity. Similar phenotypic changes can occur due to 

changes in ECM composition and stiffness resulting in altered mechanical forces that are able to 

modify a wide range of cellular properties as well [20-23]. Other environmental factors such as 

lack of access to nutrients or oxygen can activate stress pathways and induce changes in the 

affected cell subpopulation while leaving the remaining populations unaltered [24, 25]. It is 

important to consider the dynamic nature of tumors and that heterogeneity is not only affected by 

each of these events on their own, but by their specific spatiotemporal occurrence.  As such, 

genotypic and phenotypic alterations not only evolve in a cell overtime but in conjunction with 

an equally changing microenvironment [13, 26, 27]. Just as the microenvironment influences 

tumor evolution, reciprocal interactions have been observed as well [28-30]. Tumor cells can 

attract and regulate non-cancer cells in order to modify their own phenotype [31-33]. 
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Invasion 

Tumor cells must acquire invasive properties to metastasize [2]. Several mechanisms are 

employed by malignant cells to invade. The ease of study by readily available techniques makes 

single cell invasion the most commonly known mode of invasion [34]. Here, solitary tumor cells 

create and independently follow their own paths as they invade through the ECM, without 

forming any cell-cell contacts [34, 35]. Single cells can extend actin rich protrusions that 

proteolyze and degrade the surrounding collagens, while simultaneously attaching themselves to 

the ECM and retracting the cell body as it moves forward [5, 34]. In addition to this, some cells 

can use actomyosin contractility and squeeze themselves between spaces in the ECM in a more 

amoeboid-like manner [36, 37]. Interestingly, cancer cells can switch between these two modes 

of single cell migration [38, 39].  

In contrast to single cell invasion, during collective invasion cells invade as a group, 

keeping cell-cell contacts intact [4, 40]. Cells at the invasive front and those that trail behind are 

known as leader and followers, respectively [41, 42]. Leading cells reorganize the ECM through 

proteolysis and the exertion of tensile forces to create paths through which motile cells can 

follow and migrate [4, 5, 43]. Follower cells can expand the diameter of the tracks, creating more 

areas where additional cells invade [5, 44]. In addition, leader and followers maintain contacts 

via adherens junctions that allow the leader to pull follower cells forward in some instances [4]. 

Importantly, collective invasion is the predominant form of tumor cell migration [45-47].  

In addition to cancer cells, fibroblasts can act as leaders and generate tracks in the ECM 

through which malignant cells can invade [48-51]. Similar to cancer cells, fibroblast-led 

collective invasion involves proteolytic cleavage and force generation to remodel the ECM [48, 

51]. However, the intrinsic properties of carcinoma cells dictate their specific requirements to 



 4 

engage in fibroblast-led invasion. For instance, organotypic culture of luminal and basal like 

breast cancer cell lines demonstrated that while both cell subtypes form non-invasive spheroids 

resembling DCIS lesions, only the basal like cells were induced to invade by mammary 

fibroblasts [49]. This was because basal-like cells possess a unique ability to move within the 

spheroid [49], which is a feature of the branching morphogenesis that takes places during normal 

mammary gland development [49, 52]. Similar cell-cell exchange programs are also observed in 

epithelial tissue development, such as the lung, where cellular migration allows cell 

rearrangements that form the hollow cavities in cyst like structures [53]. Likewise, instraspheroid 

motility has been detected in kidney and salivary gland development [54, 55]. This suggested 

that malignant basal cells adopted this conserved developmental program. Tracks in the ECM 

created by fibroblast are also sufficient to promote the invasion of motile squamous cell 

carcinoma cells [50]. Consistent with findings from the investigation of fibroblast induced 

invasion, studies utilizing the luminal-like breast cancer mouse models polyoma middle T 

antigen (PyMT) have found that collective invasion requires the induction of the cytoskeletal 

protein K14 and the transcription factor p63, both basal cell proteins [41].  

 

Tumor subpopulation interactions that promote invasion 

 A subpopulation of cells in triple negative breast cancer (TNBC) cell lines was found to 

have an enhanced ability to invade in various ECM compositions, ranging from a hundred 

percent Collagen I to different ratios of a combination of Collagen I and Collagen VI [56]. 

Notably, these cells, termed trailblazers, can initiate collective invasion under conditions in 

which normal-like cells retain a ductal architecture [47, 57, 58]. Importantly, trailblazer cells 
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were capable of initiating and leading the collective invasion of intrinsically less invasive 

siblings, called opportunists [56].   

Trailblazer, and opportunist cell populations derived from TNBC cell lines manually 

based on invasive phenotype, by fluorescence activated cell sorting, or single cell cloning, can 

retain their respective invasive properties for at least 30 population doublings, demonstrating that 

the enhanced ability to invade characteristic of trailblazers can be a heritable and not just a 

stochastic event [56].  Immunofluorescence analysis and time-lapse imaging have shown how 

trailblazer cells extend actin-rich protrusions that reorganize the collagen into parallel fibers 

where cells collectively invade [56]. In contrast, opportunist cells do not extend protrusions and 

remain in a noninvasive state [56]. Notably, opportunists are capable of moving inside the sphere 

at a faster speed than trailblazers [59]. This is consistent with studies showing that instraspheroid 

motility alone does not confer an invasive phenotype [49, 60, 61]. When combined as 

multicellular clusters, opportunist cells were able to collectively invade behind trailblazers, but 

were unable to do so when the ability of trailblazers to extend protrusions and reorganize the 

ECM was abrogated [56]. Additionally, paracrine signaling from trailblazer cells did not promote 

the invasion of opportunist siblings when plated in close proximity, confirming that the enhanced 

invasive capacity of trailblazer cells facilitates opportunist invasion by creating paths into the 

ECM [56]. Thus, the path generation function of trailblazer cells is essential to promote the 

invasion of opportunist siblings.   

 

Epithelial-to-mesenchymal transition 

The activation of epithelial-to-mesenchymal transition (EMT) programs confers tumor 

cells with the ability to invade and metastasize [62, 63]. EMT is a process that normally occurs 
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during embryonic development and wound healing [64, 65]. In both normal and cancer settings, 

EMT can be activated by ligands, including growth factors such as transforming growth factor 

beta (TGFb), epidermal growth factor (EGF) and fibroblast growth factor (FGF), that initiate a 

signaling cascade upon receptor binding on the target cell [63, 64, 66]. This promotes the 

expression of transcription factors that induce the activity of the core EMT transcription factors 

Snail, Slug, Twist, Zeb1, and Zeb2 [62, 63]. These core EMT transcription factors repress 

epithelial cell–cell adhesion and polarity genes, and induce mesenchymal factors that reorganize 

the cytoskeleton, allow protrusion formation, and promote cell migration [62, 63, 67]. However, 

malignant cells can adopt this conserved developmental program which confers them an 

enhanced invasive and migratory potential by the loss of epithelial characteristics and gain of 

mesenchymal features, steps believed to be vital for metastatic dissemination [2, 68]. Therefore, 

it has been proposed that undergoing EMT is essential for tumor metastasis [19, 69-73]. As in 

normal processes, EMT in cancer promote invasion by triggering a loss of polarity and cellular 

cohesion, conferring migratory properties and the ability to reorganize the ECM [62, 64]. 

Molecular changes such as loss E-cadherin and gain of N-cadherin, epithelial and mesenchymal 

cell adhesion molecules, respectively, are commonly employed as markers of EMT in tumors 

[74-77]. Detection of Vimentin, a cytoskeletal protein expressed in mesenchymal cells, in place 

of keratins, is utilized as well [78, 79]. Together, these specific events have historically served as 

markers that a cancer cell have undergone EMT.  

 

EMT state heterogeneity 

The co-expression of epithelial and mesenchymal markers has been observed [32, 80, 

81], and cells expressing E-cadherin are capable of invasion [82, 83]. Cells with both epithelial 
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and mesenchymal properties are said to exist in a hybrid EMT state [84, 85]. Accordingly, EMT 

is represented by a range of cellular states with different degrees of mesenchymal and epithelial 

properties, as opposed to a binary event with the single outcome [32, 84, 86]. Indeed, the long-

standing belief that EMT is a binary event conducive to metastasis has been challenged by the 

realization that a range of EMT states take part in shaping the genotypic and phenotypic makeup 

of cancers [85, 87, 88].  

Cells in different EMT states can co-coexist in primary tumors [32, 80, 89]. These 

variations in cell EMT state contribute to the intratumor heterogeneity observed in many 

malignancies, that can in turn influence response to treatment, cell mode of invasion, and disease 

progression [16, 32]. Distinct EMT states can be present in particular cell subpopulations or 

transition back and forth by the action of signaling loops acting as modulatory switches [32, 90-

93]. The importance of these processes is increasingly having a central role in the prediction of 

response and treatment of cancer patients [16-18]. The progress that has been made in our 

understanding of tumor heterogeneity permits a macroscopic view in which individual cell 

behavior coalesce with sibling populations that interact among themselves [89, 94, 95] and their 

surroundings, having a reciprocal effect on their microenvironment [28-30]. Conversion from a 

non-malignant to a malignant lesion is now viewed as an incredibly dynamic process that 

integrates the acquisition of cell-intrinsic alterations that permits unregulated cell proliferation, 

motility and invasion with the ability to engage in commensal behaviors that enhance such traits 

on a population level [56, 59, 96]. Even at distant sites from the primary tumor, cancer cells 

remain dynamic with similar ongoing modifications or as a result of the additional selective 

pressures from the new microenvironment [2, 97]. 
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Trailblazer and opportunist phenotypes are controlled by distinct EMT programs. The 

transcription factor p63 promotes cell motility and opportunistic invasion by regulating a 

network of pathways that encompasses both mesenchymal and non-mesenchymal genes as well 

as microRNAs (miRs) [82, 98]. For instance, in breast cancer cells, p63 upregulates Slug and 

Axl expression, while simultaneously inducing miR205 which in turn silences Zeb1/2 [82]. This 

p63-high EMT regulatory program confers a hybrid epithelial/mesenchymal state, that allows 

motile cells to opportunistically invade while retaining some epithelial features [49, 60]. 

Importantly, p63 also suppresses the induction of a trailblazer EMT state [59]. An alternative 

p63-low EMT program confers cells with trailblazer properties. Functional analysis uncovered 

LPAR1, PPAP2B, ITGA11, PDGFRa, DOCK10, VASN, and DAB2 as genes that are 

specifically expressed as part of a trailblazer EMT and necessary for trailblazer cell invasion 

[56].These combined findings indicate that trailblazer and opportunist phenotypes are two 

separate EMT states that confer distinct invasive properties.   

EMT heterogeneity can be induced by through communication with the tumor 

microenvironment. For instance, in a model of prostate carcinoma, cancer cells promoted 

fibroblast activation which in turn triggered the fibroblast to induce EMT in the cancer cells [31]. 

Similarly, in squamous cell carcinoma (SCC) and mouse mammary tumor models, cancer cells 

were able to attract stromal and immune cells in proximal areas and this infiltration correlated 

with distinct EMT markers [32]. This suggested that non-tumor cell populations were being 

regulated by malignant cells, in turn influencing tumor cell EMT state. In fact, the degree of 

stromal cell infiltration was associated with an elevated expression of chemokines, cytokines and 

pro-angiogenic factors in tumor cells [32]. As a consequence, spatial heterogeneity is increased, 

as phenotypically distinct tumor cell populations were detected in correlation with the levels of 
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non-tumor cell infiltration [32]. Therefore, regional organization of cancer cells in different EMT 

states was observed in these tumor models, providing one of the first evidences of cells 

progressing through various degrees of EMT in vivo [32]. Importantly, the interconversion 

between the different transition states, whereby tumor populations can transition back and forth 

between different EMT states, was identified in this study, adding another factor to the EMT 

related cancer heterogeneity [32]. In all, several contextual signals can mediate the molecular 

changes and phenotypic plasticity of tumor cells, giving rise to a variety of cell subpopulations at 

certain points in time and space during cancer progression.  

 

EMT and metastasis 

Tests in orthotopic xenografts demonstrated that trailblazer cells can disseminate to the 

lungs [56]. Importantly, expression of the trailblazer EMT gene DOCK10, a guanine nucleotide-

exchange factor that activates the actin regulating small G-protein Cdc42, was required for 

metastasis [56]. Interestingly, while trailblazer cells from primary tumors actively seeded the 

lungs, few initiated colonizing growth, with the rest being micrometastatic lesions [56]. This is 

consistent with previous reports indicating that cells that undergo full EMT and adopt a 

completely mesenchymal phenotype often do not have the capacity to metastasize, as they lose 

the epithelial properties required for colonization [81, 99]. Cells that are able to retain all or part 

of their epithelial character are better equipped to colonize distant sites and given the right 

conditions eventually develop into metastatic lesions. For instance, while loss E-cadherin is 

associated with an invasive phenotype, its expression promotes metastasis in different types of 

invasive carcinomas [99, 100]. Indeed, decreased E-cadherin expression in various breast cancer 

models lead to a reduction of tumor cell proliferation and survival, decreased circulating tumor 
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cell number, and impaired colonization of cancer cells in distant organs and metastatic outgrowth 

[101]. It was further demonstrated that E-cadherin is functionally active in the regulation of 

metastasis at different stages during the malignant progression towards a distant site [92]. 

Consistent with this idea, EMT tumor cells revert to an epithelial state once at the metastatic site 

by undergoing the process known as mesenchymal to epithelial transition (MET) [70, 71, 102]. 

In fact, metastatic lesions often exhibit epithelial features and retain E-cadherin expression [99, 

103].  

As result of these studies, the necessity of EMT for metastasis has been debated. In fact, 

various studies have indicated that EMT is not required for metastasis based on the lack of a 

requirement of an individual EMT transcription factor (TF) [100, 103, 104]. However, these 

conclusions do not consider that a single EMT TF is no required for all EMT programs. In 

addition, it has been shown that the process of EMT as part of the metastatic cascade is often 

context dependent. For instance, in a model of squamous cell carcinoma (SCC), EMT in primary 

tumors and MET at secondary sites was essential for lung and lymph node colonization and 

growth [70]. In contrast, SCC tumors transplanted into immunocompromised mice were able to 

metastasize without apparent EMT, and actually higher levels of epithelial cells were found in 

the lungs, implicating an essential role of the immune system in this process [70]. Taken 

together, this suggests that additional mechanisms are present in vivo to promote the progression 

to metastatic disease.  

Interactions between cancer cell subpopulations in different EMT states might also lead 

to their dissemination [96]. While trailblazer cells lack the epithelial features necessary for 

colonization, and opportunists do not invade on their own, cooperation between the two can 

overcome the limitations of each cell population alone [56]. The higher p63 expression found in 
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opportunist cells, confers them an increased proliferative capacity, in contrast to the p63-low 

EMT state that permits trailblazer invasion [59]. As a transcriptional activator, p63 is involved in 

the regulation of epithelial cell differentiation and fate [60, 105, 106]. It has a role in modulating 

epithelial morphogenesis and the control of epithelial stem cell compartments during embryonic 

development as well as adult stem cells [105, 106]. During cancer development, p63 is known to 

promote tumor initiation and cell proliferation in skin, breast and lung [98, 106]. In cancer cell 

lines, p63 is required for colony formation and can be found in the myoepithelial cells 

surrounding DCIS lesions upon transplantation in mice [59, 82], consistent with its role as a 

basal transcription factor. Importantly, p63 sustains a hybrid EMT state in opportunist cells [59]. 

Conceivably, opportunist cells retain a higher metastatic potential once they reach the distant 

sites compared to trailblazer siblings. Thus, the interaction between trailblazer and opportunist 

cells may accelerate the progression to metastasis as it eliminates the requirement for invasive 

gene programs to be active in each cell population. In fact, it has been shown that cells lacking 

EMT characteristics can be induced to invade and metastasize by crosstalk with cells in a fully 

mesenchymal EMT state [89, 94, 95]. Thus, the functions of EMT programs are still a crucial 

part of the metastatic process, whether on their own in a context-dependent manner or in a way 

that unites cell-intrinsic changes with interactions permissible to cancer progression. As such, 

interactions between cells in distinct EMT states have been an area of increased focus in cancer 

research during recent years.  

 

EMT heterogeneity and therapy resistance  

EMT heterogeneity may contribute to innate and acquired resistance to treatment. For 

example, trailblazer cells in a p63-low EMT can be enriched at the G0/G1 phase, indicating they 
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exist in a quiescent stage of cell cycle [59]. These slow cycling cells might be resistant to 

cytotoxic agents that rely on persistent cell replication for their therapeutic effect. In fact, it has 

been shown that mesenchymal cancer cells are more resistant to cyclophosphamide and 

Gemcitabine treatment when compared to cells that possess epithelial character [103, 104]. 

Therapeutic resistance is a constant source of patient relapse [107, 108]. Response to treatment is 

also affected by the acquisition of new somatic mutations during cancer progression [109-111]. 

This is especially relevant under targeted therapies, when genetic alterations render the intended 

gene target obsolete [112]. Combinatorial approaches and new generation of therapies aid in 

extending overall survival, but oftentimes they fall short due to further mutations [112]. 

Moreover, cancer subtypes such as TNBC that lack protein targets towards which direct 

treatment have limited therapy options [113]. Importantly, heterogeneous subpopulations of 

trailblazer and opportunist cells have been found in TNBC cells lines and a trailblazer gene 

signature correlates with poor breast cancer patient outcome  [56], bringing up the possibility 

that characterization of these two distinct EMT states can translate into novel cancer therapies. In 

skin and breast cancer models, phenotypic plasticity also exhibited a critical role in drug 

resistance and relapse [18, 114]. Importantly, these cancer types have a tendency to appear to 

undergo EMT and show increased regional heterogeneity, with mesenchymal-type cells often 

found closer to tumor stromal boundaries [32]. Patient response is significantly affected with a 

high degree of tumor heterogeneity [16, 17]. Indeed, tumor cell heterogeneity can give rise to 

cell populations that are intrinsically resistant to a particular drug or that have a greater potential 

to acquire resistance to initial treatment strategies [16, 17]. EMT may also be determinant in the 

progression of disease and subsequent treatment efficacy as it can contribute to chemoresistance 

[103, 104, 115]. It has been suggested that cells in different EMT states may accelerate the 
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progression to metastatic disease and promote resistance to treatment [56, 59, 89, 93-95]. 

Therefore, a comprehensive approach incorporating temporal as wells as phenotypic changes 

should be implemented when developing new therapeutic strategies, including the considerations 

of invasive properties of cell subpopulations. At minimum, phenotypical invasive differences 

should serve as a prognostic factor since the presence of intrinsically invasive cells even at little 

amounts could facilitate the progression to metastasis [56].  

 

Model systems for investigating EMTs that promote invasion and metastasis 

It is generally recognized that the extracellular environment can influence cell intrinsic 

properties [21, 116, 117]. Therefore, preserving the tridimensional (3-D) cell arrangement that 

reflects the physiological organization of tissues and tumors should be the goal in order to better 

evaluate the biology and behavior of cancer cells. For this reason, organoid culture systems are 

increasingly being utilized for disease modeling and drug testing [118-121]. As opposed to cells 

lines in two-dimensional (2-D) surfaces, organotypic cultures give a closer resemblance to the 

structures encountered in human and animal organs [122]. Moreover, 3-D culture systems allow 

for the study of cancer cell biology in a context that includes the forces that surround them, a 

crucial aspect for the study of EMT as it has been found that physical forces and ECM 

composition can regulate motility, invasion and expression of EMT genes [117, 123, 124]. 

Indeed, research has shown that monolayer culture itself can alter the patterns of gene 

expression, promote mitotic defects and modify the general properties of cells [20, 125]. For 

instance, prostate cancer cells grown as 3-D spheroids display a different pattern of expression of 

EMT markers as compared to cells cultured as monolayers [125]. Moreover, studies utilizing 

multiple primary cell types demonstrated that when epithelial cells are cultured as monolayers, 
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chromosome segregation fidelity is lost [20]. In fact, the tissue architecture provided by 

organotypic culture is able to rescue these mitotic defects [20]. The 3-D spatial organization 

provided by organotypic culture also addresses the cellular interactions that occur during 

collective invasion and models the behavior of cell subpopulations invading through ECM [47]. 

In addition, because 3-D culture systems better recapitulate the in vivo tumor microenvironment, 

they provide an improved platform on which to evaluate potentially clinically active drugs [118]. 

Pre-clinical studies usually employ 2-D cultured cell lines to assess the cytotoxic effects of 

anticancer drugs. However, studies investigating the activity of chemotherapeutic drugs in 2D 

and 3-D culture have uncovered that there is increased sensitivity in 2-D cultured cells when 

compared to 3-D spheroids [118]. This helps explain an underlying issue of cancer drug 

development when drugs deemed to be clinically active cell line-based models often fail to 

produce a response in patients, highlighting the importance of maintaining tissue architecture 

when investigating malignant disease.  

To overcome the limitations presented by conventional 2-D cell culture methods that 

prevent the faithful characterization of tumor cells in their native state many readily available 

matrices have been developed. These ECM mimics are composed of synthetic collagens and 

other proteins found in the stromal component of tissues [126, 127]. Its resemblance to 

physiological structures has been shown by culturing both cell lines and tissues where overtime 

the 3-D structures recapitulate physiological aspects such as the lumen and ducts [52, 56, 61, 

128]. In all, maintaining the tissue architecture, as well as the interactions among tumor cells and 

between tumor cells and their microenvironment are crucial for enhancing our understanding of 

EMT in cancer development and progression. For that reason, other approaches employing 

animal models have been favored, even with their own limitations. 
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 Animal models are a readily expandable resource that can in many ways mimic 

conserved aspects of human disease [129-131]. Genetically engineered mouse models (GEMM) 

of different cancer types have been developed and gene signature testing have revealed that they 

can often recapitulate human cancer histological subtypes [132, 133]. For instance, 

transcriptomic analysis of several mouse models of breast cancer identified matching GEMM 

with their luminal-A, luminal-B, claudin-low, HER2 positive, and basal-like counterparts [130, 

133]. Not only do transgenic models replicate the genetic alterations found in human 

malignancies, but they also allow for the study of tumors in immune competent conditions. 

Xenograft studies using immune deficient mice does not provide the full picture of the influence 

that immune pathways can have on tumor evolution, as certain aspect of the immune response 

have to be silenced to avoid cell and tissue rejection [129]. This immune deficiency prevents the 

complete analysis of interactions between cancer cells and their environment, since immune cells 

can have major roles on promoting invasion and metastasis [134]. In this way, GEMM can more 

accurately depict the natural progression of cancer diseases. For instance, the C3(1)/SV40 Large 

T-antigen (C3-TAg) transgenic mouse model of breast cancer recapitulates a multistage 

progression to invasive carcinoma [135]. It can sometime metastasize, although the incidence of 

metastasis is 15% with the appearance of multiple tumors which can sometimes prevent survival 

surgeries [135]. In this model, the SV40 Large T-antigen targets the epithelial cells of female 

mouse mammary ducts [135]. Expression of this antigen silences p53 and Rb proteins in 

mammary cells, promoting an unchecked progression thru the cell cycle culminating in 

malignant lesions [132]. Histologically, the C3-TAg mouse model resembles the human basal-

like breast cancer subtype, and do not express the receptors for estrogen, progesterone and HER2 

[132, 135]. For this reason, is often utilized in studies of TNBC. Additional transgenic models 
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such as the MMTV-Neu or PyMT are associated with luminal subtypes [82, 133]. These 

representative models can therefore more accurately predict drug response in human cancers 

[136]. In addition to genomic similarities, GEMM can reflect the overall phenotypical 

differences, invasive modalities, and the effect of cell subpopulations on one another observed 

during patient cancer development. Therefore, mouse models of spontaneous tumors provide a 

great tool for understanding the regulatory programs that are active in distinct cancer cell 

populations and how their interactions promote the progression from a benign to an invasive 

cancer. 

 

Summary of findings 

In an effort to understand how the ability to metastasize is acquired during tumor 

development, the work presented here focused on elucidating factors that regulate the conversion 

to a trailblazer EMT state and promote interactions between cell populations in vivo. Through 

analysis of tumor development in the C3-TAg mouse model, we found evidence of cells in p63-

high and p63-low EMT states interacting and collectively invading into the stroma. Functional 

studies showed that integration of the ERK1/2 and TGFb signaling pathways induced the p63-

low trailblazer EMT and conferred cells with the ability to lead collective invasion. 

The RAS-activated MAPK signaling cascade composed of RAF, MEK and the effector 

kinase ERK supports cell proliferation and differentiation in epithelial cells as well as motility 

and invasiveness during embryogenesis, tissue regeneration and cancer [137, 138]. Signal 

transduction starts upon ligand activation of receptor tyrosine kinases (RTKs) by mitogens and 

growth factors [139-141]. Receptors, such as EGFR initiate a series of downstream protein 

phosphorylation events, leading to the activation of extracellular signal-regulated kinases, or 
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ERK1/2 [139-141]. Phosphorylated ERK1/2 in turn regulate the expression of protein targets 

including components of the AP-1 (activator protein 1) complex [138, 142].  

AP-1 is a dimeric transcription factor that contains members of the JUN (cJun, JunB, 

JunD) and FOS (cFos, Fra1, Fra2 and FosB) protein families [143]. Although the AP-1 complex 

can be composed of heterodimers and homodimers formed out of different combinations of JUN 

and FOS proteins, heterodimerization of FOS family members with JUN proteins form more 

stable, transcriptionally active complexes relative to JUN homodimers [144, 145]. In addition to 

its role in the proliferation and differentiation of normal tissue, AP-1 has been implicated in the 

pathogenesis of multiple malignancies and it is involved in cancer cell proliferation and survival, 

transformation and migration [143-146]. However, some AP-1 family members may also have a 

role in tumor suppression [144, 147-149]. For instance, in studies of primary breast tumors, JunB 

expression was associated with decreased tumor size and tumor stage [145] and JunB mRNA 

was found to be highly expressed in nodal negative tumors [145, 150]. Mice lacking JunB 

expression in the myeloid cell lineage developed progressive myeloid leukemia, arising from 

reduced apoptosis and increased cell proliferation [149]. In ovarian carcinomas, loss of cFos 

expression correlated with disease progression [147] and in murine hepatic cells, overexpression 

of cFos lead to inhibition of cell cycle progression, hepatocyte cell death and suppression of 

tumor formation in vivo [148]. However, evidence indicate that cFos possesses tumor promoting 

as well as tumor suppressing activities [144].  These dual functions can be regulated by cFos 

dimerization partners, promoter accessibility and protein co-activators, but can also be dictated 

by tumor type, stage and genetic background [144, 147]. The oncogenic properties of AP-1 are 

potentiated by the activity of other oncogenic pathways as well [144]. The primary interacting 

pathway of AP-1 is the RAS signaling pathway, since cell transformation by activated RAS or 
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MEK1 stimulates the expression of AP-1 components [144]. Activated RAS induces Fra1 and 

cJun [144]. and Fra1 modulates AP-1 dimer composition by promoting the stabilization and 

accumulation of cJun in response to oncogenic RAS signaling [151]. Notably, 

heterodimerization with Fra1 controls cJun turnover, making Fra1 a posttranslational regulator of 

its dimerization partner cJun [151]. 

Fos-related antigen 1 (Fra1) is encoded by the FOS-like antigen 1 (Fosl1) gene and it is 

activated by the RAS-RAF-MEK-ERK pathway at levels of transcription and post-translational 

modification [138, 146]. Transcriptionally, regulation occurs via an AP-1-dependent intronic 

enhancer in the Fosl1 gene [146]. Post-translational stabilization is dependent on 

phosphorylation by ERK of two serine residues (Ser-252 and Ser-265) at the C-terminal domain 

[146, 152, 153]. When not phosphorylated, this C-terminal destabilizer induces the ubiquitin-

independent proteasomal degradation of Fra1 [146, 152, 153]. Different levels of ERK activity 

control the expression of Fra1 [154]. Basal levels of ERK activity mainly regulate the 

transcription of the Fosl1 gene, while higher levels of activity are required to stabilize Fra1 

against proteosome-dependent degradation  [154]. Moreover, it has been shown that there is a 

linear relationship between the total expression levels of FRA1 and the duration of ERK activity, 

and the rate of production of Fra1 has a linear relationship with the total activity of ERK [138]. 

Several studies have found that Fra1 is involved in the control of many features of human 

malignancy, including EMT activation, cell proliferation, migration and invasion [145, 146, 155-

157]. It has been shown that Fra1 is involved in many steps of the metastatic cascade in breast 

cancer including filopodia formation, anchorage-independent growth, intravasation and 

extravasation, and its expression stimulates EMT-like programs in metastatic cells [158-160]. 

Fra1 has also been implicated in EMT through its modulation of Zeb1/2 [155, 161], Slug [162], 
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TGFb  [155] and E-cadherin [158]. Notably, Fra1 is overexpressed in several types of human 

cancers, including breast cancer [145, 153, 156, 157]. Among AP-1 members, high levels of Fra1 

have been associated with breast cancers molecularly classified as TNBC [145, 163]. In studies 

correlating the expression of AP-1 members with breast cancer clinicopathological parameters, 

Fra1 was significantly upregulated in tumors classified as ER/PR negative and its expression was 

increased in TNBC tumors relative to luminal carcinomas [145]. Similarly, Fra1 is elevated in 

TNBC cell lines as compared to ER positive breast cancer cells [164, 165]. Moreover, Fra1 

expression correlates with a poor prognosis in TNBC patients [163].  

In our current findings, the transcription factor Zeb1 was at the core of EMT regulation, 

whereby ERK-dependent Fra1 signaling acted as a master regulator of trailblazer type invasion 

in cells under distinct EMT states, as defined by their specific epithelial and mesenchymal 

properties. While Fra1 expression was required for invasion of cells expressing various levels of 

epithelial and mesenchymal markers, TGFb pathway activation enhanced the invasion of cells 

that retained an epithelial character. Prolonged exposure to exogenous TGFb or to the tumor 

microenvironment in syngeneic mouse models enhanced the invasive phenotype of hybrid EMT 

cells. Importantly, integration between EGFR and TGFβ pathways has been previously shown, 

but the mechanistic basis of their crosstalk has been limited to how activation of the EGFR-ERK 

pathway induces canonical EMT features including suppression of E-cadherin [166-170]. 

However, our current findings show that Fra1 suppression did not alter E-cadherin expression or 

reduced its previously identified gene targets Zeb1/2 [155].  Overall, the data presented here 

provides direct evidence of how cell intrinsic properties dictate cellular response to extrinsic 

factors in vivo, specifically demonstrating how Fra1-expressing cells acquire a trailblazer EMT 

phenotype in response to TGFb. Moreover, the induction of Fra1 by a parallel signaling network 
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is required for TGFb to promote the conversion to a trailblazer EMT state. Together our results 

reveal cell intrinsic properties that permit paracrine signaling from the microenvironment to 

induce a trailblazer EMT state and collective invasion.   
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CHAPTER II: METHODS 

 
General methods 

Genetically engineered mice. The C3-TAg [FVB-Tg(C3-1-TAg)cJeg/Jeg] mice [135] were a 

gift from Dr. Anna Riegel. Mice were housed and bred in accordance with a protocol approved 

by the Institutional Animal Use and Care Committee at Georgetown University and in 

compliance with the NIH Guide for the Care and Use of Laboratory animals. Female mice were 

used for all experiments.  

 

Tumor explants. The largest tumors from female C3-TAg mice were minced and tumors were 

digested for up to 120 min at 37°C in a mixture of 1mg/ml Collagenase, 2U/µl DNase, 5% FBS 

in DMEM/F12. Digested tumors were pelleted at 80 x g for 1 min and the supernatant was 

discarded. Tumor organoids were then rinsed up to 5 times in 10 ml 5% FBS in DMEM/F12. 

Organoids were plated in a mixture of 30 ul of 2.4 mg/ml Rat tail collagen (354236, Corning) 

and 3 mg/ml growth factor reduced Matrigel onto a base layer of 20 µl of Collagen I/Matrigel. 

The organoids in ECM were overlaid with DMEM/F12 supplemented with 1% FBS, 1X ITS 

(Sigma, I3146), non-essential amino acids (Sigma, M7145) and 10 ng/ml FGF2 (Peprotech, 100-

18C). When tested, treatments were added at the time of media addition using media without 

FBS or FGFb. Organoids were allowed to invade for 24-48 h fixed and imaged as described in 

next section, Quantification methods for organoid invasion, unless otherwise indicated. 

 

C3-TAg tumor cell and organoid lines. Cells were generated from C3-TAg tumors. Briefly, 

tumors organoids were generated as described in methods for tumor explants. Organoids were 

then plated in a cell culture dish and allowed to attach as monolayers. Cells were cultured at 5% 
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CO2, humidified, and at 37°, and were routinely used within 25  passages. Clonal cell lines and 

1863T cells were grown in base media: DMEM/F12 (Corning, 10-092-CV), 1x penicillin 

streptomycin solution (Hyclone), supplemented with 1% FBS, 1X ITS (Lonza, 17-838Z), non-

essential amino acids (Sigma, M7145) and 10 ng/ml FGF2 (Peprotech, 100-18C). 1863 cells 

were cultured in base media supplemented with B27 (Fisher, 17504001), 

50 ng/ml EGF (Peprotech,  AF-100-15  ),  Y27632  (Peprotech,  1293823) , N-

acetylcysteine  (MP  Biomedicals,  194603)  and  A83-01  (Peprotech,  9094360). For the 1339 

organoid line (Fig. 3.9), tumor explants were dissociated into single cell suspensions using 

TryPLE (Gibco, 12605- 010). The cell suspensions was plated at a density of 200,000-500,000 

cells per well in a 24-well ultralow adhesion plate and allowed to clump overnight in Organoid 

Media (DMEM/F12 (Corning, 10-092-CV),  B27  (Fisher,  17504001), ITS (Lonza, 17-838Z), 

non-essenOal amino acids (Sigma, M7145), 10 ng/ml FGF2 (Peprotech,  100-

18C)  50  ng/ml  EGF  (Peprotech,  AF-100-15  ),  Y27632  (Peprotech,  1293823)  N-

acetylcysteine  (MP  Biomedicals,  194603)  and  A83-01  (Peprotech,  9094360). Cell clumps 

were collected, spun down to remove media, and resuspended in 200 uL of Matrigel 

(Corning, 10-12 mg/ml  stock  concentration,  #354230) or Culturex (Bio-Techne, 3533-005-02) 

and plated in a 6-well low adhesion plate overlaid with organoid media. 

Organoids were passaged  at  least  once per week by detaching from the Matrigel or Cultrex 

matrix with Dispase (Sigma, SCM133) and repeating the cell suspension and clumping process. 

Virus was produced and cells were infected to generate stable cell lines as described 

(31). Treatments were added at the time of plating in ECM. M6 cell lines were grown in 10% 

FBS, RPMI, 1x penicillin streptomycin solution (Hyclone). Cells were cultured at 5% CO2, 

humidified, and at 37° C. 
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Orthotopic experiments. REAR mice, which carry only one copy of the C3(1)/Tag-antigen 

transgene and do not develop mammary tumors or the associated phenotypes of the original 

C3(1)/Tag transgenic mice [171], were employed for syngeneic transplantation experiments. 

This sub-line of mice is tolerant to SV40 T-antigen expressing cells while having an intact 

immune system [171]. In all experiments, 1339 organoids were dissociated using TryPLE 

(Gibco, 12605- 010) and 6-8-week old female C3-TAg REAR mice were injected bilaterally in 

the fat pads with 500,0000 1339 organoid cells. Mice were euthanized and primary tumors were 

excised for analysis on day 27.   

 

3D culture experiments. Experiments in 3D culture were performed and quantified as described 

in “Quantification methods for organoid invasion”. When tested, treatments were added at the 

time of plating in 3D. For spheroid cluster experiments employing fresh explants, isolated 

organoids were dissociated into single cells using TrypLE (Gibco, 12605- 010), and clustered 

alone or together with non-invasive clones as described in Chapter II. For analysis of single cells, 

cell lines or dissociated organoids were plated in 3D at a density of 5,000-20,000 cells per well, 

as described in the next section, Quantification methods for organoid invasion.  

 

Live cell imaging. Imaging was performed using a Zeiss LSM800 laser scanning confocal 

microscope enclosed in a 37˚C chamber supplemented with humidified CO2 (Solent).  Images 

were acquired every 30 min for 14-18 hrs with a 10x objective (Zeiss) using ZenBlack software 

(Zeiss). At least 15 different x,y coordinates with 5 to 7 z -slices over 50-100 μm span for each 

condition were imaged in parallel. Treatments were added at the time of plating in ECM. 
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Staining of primary tumor samples. Immunohistochemical staining and H&E was performed 

as previously described [49]. For immunofluorescence analysis, formalin-fixed, paraffin-

embedded tissue sections were deparaffinized using xylene and rehydrated in a series of alcohol 

washes. Antigen retrieval was performed by placing slides on a low boil in sodium citrate (pH 

6.0). Slides were blocked in 20% Aquablock (Abcam, Cambridge, MA) in TBST before being 

incubated overnight with primary antibody followed by species-specific secondary antibodies 

(Table 2) conjugated to AlexaFluor488, AlexaFluor546, or AlexaFluor647, and counterstained 

with Hoechst for 1 hr. Antibodies were prepared in 5% BSA in TBST.  

 

Quantification of cellular protrusions and K14/K8 expression in leading cells. At least 10 

organoids from normal mammary tissue or C3-TAg tumors from 3 separate experiments were 

analyzed. 10x images of Phalloidin and Hoecsht stained organoids were obtained using a Zeiss 

LSM800 laser scanning confocal microscope. Only organoids with a center mass of 20 cells or 

more were considered for analysis. Analysis was performed after manual quantification of the 

number of cellular protrusions extended from the main organoid mass. Invasive protrusions were 

defined as one leading cell followed by one or more cells moving away from the main organoid 

mass. For expression of keratins in leading cells, at least 10 organoids stained with Phalloidin, 

Hoechst, K14 and K8 were analyzed. Seven Z slices of 10 um intervals over a total span of 100 

um were acquired, and the leading cells of each protrusion were designated as K14+, K8+, 

double positive or double negative.  

 

RNA isolation. Total RNA was isolated from 2D culture using RNAeasy purification columns 

(Qiagen). For RNA isolation from organotypic culture, 60,000-80,000 single cells or freshly 
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digested tumor explants were resuspended in 500 uL of 80% Collagen I/20% Matrigel mix and 

plated on 500 uL of a basement layer of Collagen I/20% Matrigel in base media unless otherwise 

indicated. Cell lines were grown for 6 days and explants were allowed to invade for 24-48 hrs. 

RNA isolation from ECM was performed as previously described [172]. When tested, treatments 

were added at the time of plating in ECM. For RNA sequencing, replicate samples from a tumor 

explant were obtained by digesting the tumor, aliquoting and freezing down, then thawing and 

plating in separate experiments for RNA isolation. Replicates of cell RNA were obtained by 

plating different cell passages in separate experiments. 

 

RNA sequencing. RNA sequencing was carried out by the Genomics and Epigenomics Shared 

Resource at Georgetown University. cDNA libraries were generated using the Illumina TruSeq 

Stranded Total RNA Library Preparation Kit (Illumina). All samples submitted for sequencing 

had an RNA Integrity Value > 9.0. cDNA libraries were sequenced on the Illumina NextSeq 500 

using 75 bp pair end reads per sample. Heatmaps showing the normalized reads of candidate 

genes from tumor explants and non-invasive cells were generated with GenePattern software 

using the HeatMapImage module.  

 

Quantitative real-time PCR. cDNA was prepared using the iScript cDNA Synthesis Kit (Bio-

Rad). cDNA was amplified with SYBR Green Supermix (Bio-Rad). Actin was used to calculate 

relative mRNA expression. For expression of p63, E-cadherin in clones, and trailblazer genes, 

cDNA was amplified with Applied Biosystems 2X TaqMan using an Applied Biosystems 7500 

Real-Time PCR System. GAPDH was used to calculate mRNA fold change. The ∆∆CT method 
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was applied to quantify relative gene expression. Primer information and sequences are located 

in Table 3.   

 

Immunoblot analysis. Cells were lysed in RIPA buffer supplemented with a protease inhibitor 

cocktail (Calbiochem) as described [56]. Equal amounts of protein were separated by SDS-

PAGE, transferred to Immobilon-FL polyvinylidene fluoride (PVDF) transfer membrane 

(Millipore), and immunostained. Antibodies are detailed in Table 1. Immunoblots were 

visualized using an Odyssey infrared scanner (LI-COR).  

 

siRNA experiments. siRNA experiments were performed as described in the next section, 

Quantification methods for organoid invasion. The details of the sequences for each siRNA pool 

are located in Table 2. 

 

Vertical invasion assay. 10,000-18,000 cells were reverse transfected in triplicate in a 96-well 

plate with 50 nM OnTargetplus, or 50 nM Sigma siRNAs using RNAiMax transfection reagent 

(Invitrogen). After 48 hrs, media was replaced with 50 µl Matrigel/Collagen matrix (5 mg/ml 

Matrigel and 2.1 mg/ml Collagen I), followed by growth media, and incubated at 37°C.  Forty-

eight h after ECM addition, cells were imaged with a 10X objective on a Zeiss LSM800 laser 

scanning confocal microscope. Twenty-one z -slices at 10-um intervals over a total span of 200 

μm were acquired for 9 tiled x,y positions per well.  At least 3 wells (27 x,y positions total) were 

imaged per condition in each experiment.  ImageJ software (NIH) was used to process images 

and quantify invasion.  Relative invasion was calculated by counting the total number of Hoechst 

stained or H2B:GFP-labeled cells that had migrated 40-50 µm or more above the monolayer.  To 
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correct for possible differences in proliferation rates, the total relative cell number for each well 

was determined by counting the number of cells in the monolayer. The number of invading cells 

was then divided by the number of monolayer cells to determine the normalized invasion for 

each well. To determine the relative invasion for each experiment, the normalized invasion value 

for each condition was divided by the normalized invasion for the control wells transfected with 

an siRNA pool that does not target any mouse genes.    

 

Statistical methods. Normality was determined by using the Shapiro-Wilk test. Data with a 

normal distribution were analyzed by two tailed Student’s t-test. Data that did not pass a 

normality test were analyzed by Mann-Whitney U test. All analysis performed using Graphpad 

Prism. 

 

Quantification methods for organoid invasion 

Protocol for cell clusters. The protocol here describes an automated way to analyze 

multicellular clusters. This allows for a reproducible and unbiased method to evaluate collective 

invasion. Although described for the analysis multicellular spheroids, this method can be 

employed for analysis of organoids from primary tumors as well. 

 

 
1. siRNA transfection and cluster formation  

 

a. Reverse transfect 12,000-17,000 cells per well in two wells of a 96-well plate. We used 

50 nM of OnTargetplus, siGenome or Sigma siRNAs and RNAiMax as the transfection reagent 
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(Invitrogen). “Control” cells were transfected with a pool of siRNAs that does not target mouse 

genes. 

Note: If not transfecting cells, skip ahead to step d.  

b. After 24 h, detach cells and prepare cell suspension of 1,000 cells per well, in a total 

volume of 200 uL. 

c. Transfer cell suspension to 96-well Nunclon Sphera low adhesion round bottom plates 

(Thermo Scientific), dropwise careful not to touch sides or bottom of the wells.  

Note: Using 12 wells per condition was enough for quantification of one well of clusters per 

chamber slide. However, some clusters might be lost since they can adhere to pipet tip of tube 

surface during the plating process.  

d.  Incubate at 37˚C for 24 h. 

Note: Cluster formation time can vary depending on the cell line used. Incubate from 24-72 h, 

taking into account knockdown efficiency time if transfecting.  

 

2. Cluster embedding into 3-D culture   

 

a. Working on ice, prepare neutralized type I rat tail collagen (BD Biosciences) by diluting 

the stock collagen with serum free base medium to a final working concentration of 3 mg/mL. 

Add 11 µL of 10x PBS and 1.2 µL 1 N NaOH for every 100 µL of diluted collagen to achieve a 

neutral pH. 

Note: Read pH using a litmus paper and make sure it is between 7-8. Adjust with additional 

NaOH if necessary.  
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b. Keep Collagen I on ice and incubate at 4˚C for 1 hr to allow for neutralization and 

activation. 

c. Prepare a mixture of growth factor reduced Matrigel (BD Biosciences, 5 mg/ml stock 

concentration) or Cultuex Trype 2 (Trevigen), with the neutralized Collagen I at the desired ratio. 

We used 80% Collagen I with 20% Matrigel or Cultrex.  

d. Plate 20 μl of a basement layer of Matrigel/Collagen I in 8-well chamber slides (BD 

Falcon) and allow to solidify by incubation at 37˚C for 1 hr. Plate carefully to avoid bubbles. 

Note: Base layer can be plated 1-2 days in advance and kept in a humidifier chamber inside the 

tissue culture incubator in sterile conditions to avoid drying of the ECM. 

e. After cluster formation, using a cut pipet tip carefully remove clusters from the wells of 

the round bottom plate into a tube with media for centrifugation.  

f. Remove media leaving the pellet as dry as possible. Using a cut pipet tip, gently 

resuspend cell cluster pellet in 30 μl of Matrigel/Collagen I mix by carefully pipetting up and 

down to avoid formation of bubbles, and slowly add dropwise onto the base layer in the 

corresponding well of the chamber slide.   

Note: Avoid the generation of air bubbles while working with the ECM as this might affect 

invasion kinetics as well as image acquisition.   

g. Incubate the chamber slide at 37˚C in the tissue culture for 1 hr to allow the ECM to 

solidify.  

h. Add growth medium gently to prevent detachment of the ECM from the well surface.  

Note: Warm up the growth medium at 37˚C before adding to the wells as cold temperature will 

degrade the ECM. 

i. Place back in the 37˚C incubator and allow clusters to invade for 24-48 h. 
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Note: Invasion time points will vary depending on the cell line. Avoid letting the assay for too 

long since contractile forces can cause the ECM to retract and detach from the well surface.  

 

3. Immunofluorescence staining  

 

a. Remove the media from the wells by inverting chamber slide, aspiration or pipetting, 

carefully so as to not detach the ECM from the wells while keeping as dry as possible. 

Note: Samples can start to dry in the absence of media/solutions for long periods of time. Work 

through 1-2 wells at a time if possible. 

b. Prepare 2% formaldehyde in 1X PBS and fix the chamber slide by carefully adding 400 

uL to each well. Incubate at room temperature for 1 h to overnight in a humidified chamber at 

room temperature.  

c. Permeabilize the wells with 0.5% Triton X-100 in 1X PBS for 10 min to 1 hr at room 

temperature in the humidifier.  

Note: 0.5% Triton X-100 can be made ahead of time and stored at Room temperature  

d. Prepare IF Buffer: 0.1% bovine serum albumin, 0.2% Triton X-100, and 0.05% Tween-

20, in 1X PBS.  Filter and store at 4° C in order to extend shelf-life. 

e. Prepare blocking solution by making 10% goat serum in IF buffer and filtering 

afterwards to get rid of any debris from the goat serum.  

Note: IF buffers and blocking solution must be used at room temperature as cold buffers will 

dissolve the ECM. 
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f. Remove the 0.5% Triton from the wells by inverting chamber slide, aspiration or 

pipetting, carefully so as to not detach the ECM from the wells while removing as much of the 

solution as possible. 

g. Add 250 uL of warmerd blocking solution  at 37˚C to each well and incubate for 1 h at 

room temperature in the humidifier chamber.  

h. Meanwhile, prepare nuclear and cytoskeletal stainning solutions by diluting Hoechst 

33342 (Invitrogen) to 1:1000 and Phalloidin (BD Sciences, Alexa fluor 546 labelled) to 1:200 in 

blocking solution. Use the same diluting process if using primary antibodies, but dilutions should 

be determine empirically by the experimenter. Make enough to cover ECM (approximately 175-

250uL of antibody solution per well of an 8 well chamber slide).  

Note: Antibodies and antibody solutions should be kept away from direct light. Cover diluted 

antibody solutions with aluminum foil and/or keep stored away from direct light while waiting 

for blocking incubation. 

i. Remove blocking buffer, add 175-250 uL of staining solution per well, and place slide 

with lid removed in a humidified chamber covered with aluminum foil. Incubate at room 

temperature for 30 min to 1 hr. If using primary antibodies, this step should go overnight. Keep 

this container wrapped in foil to place slides in for the remainder of the experiment in order to 

avoid bleaching the antibodies. 

Note: The chamber lid must be removed in order to prevent wicking of antibody between wells.  

j. Carefully remove staining or antibody solution and wash wells three times with 500 uL of 

IF buffer at room temperature, at 5 min per wash.  



 32 

k. Gently remove final wash and rinse away antibody solution by adding 500 uL 1X PBS to 

each well. Thoroughly remove PBS wash and proceed to mount the slide according to 

manufacturer’s instructions. We used ProLong Gold antifade reagent (Invitrogen) for mounting.  

l. Allow the ProLong to set for 24 h before storing slides at -20° C or imaging. 

 

4. Imaging and invasive protrusion analysis   

 

a. Imaging was performed using a Zeiss LSM800 laser scanning confocal microscope and 

widefield camera (Axiocam).  Images were acquired with a 10x objective using the Zen Blue 

software. 

b. Select tile regions to image that are big enough to cover the entire cluster so as to not 

miss any part of the protrusions. However, the number of tiles should not change within the same 

experiment.  

c. Set one support point at the center of the cluster with Z range that spans the entirety of 

the spheroid. Each Z slice should be no more that 12 microns. 

d. Acquire the multichannel images of Hoechst and Phalloidin at a 1024 x 1024 frame size, 

with a scan average, pixel dwell time and speed that gives the best signal to noise ratio.  

Note: These parameters will increase sample exposure time. Therefore, they can be adjusted 

according to the researcher’s preference and as long as it gives a clean quantifiable image.  

e. Export each cluster confocal image in TIFF format, making sure to save both individual 

and merged imaging channels (Fig. 2.1). 
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f. Open the Hoechst channel TIFF images in the ImageJ software (NIH, Bethesda, MD, 

USA)  

g. Select a region of interest to specifically analyze a single spheroid by drawing around the 

cluster to be analyzed and clickicking “Edit>Clear Outside”. 

h. Use the oval or freehand selection tool to draw the outline of the center mass and remove 

it, leaving only the cell protrusions for analysis.  Click “Edit>Clear” and save this image as a 

TIFF. Repeat for all the clusters to be analyzed.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 2.1 Representative images of invading clusters. Exported TIFFs of confocal images 
for analysis including individual nuclear and actin stained channels. 

Hoescht Phalloidin Merged 

Figure 2.2 Invading protrusions of selected cluster. Image of collectively invading 
nuclei to be analyzed.  
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i. Load the TIFF image with a cleared center mass into ImageJ. 

j. Covert to a masked image by using the commands “Process>Binary>Convert to mask”. 

ImageJ often selects a default threshold for masking. If necessary, change it to more accurately 

capture the area covered by the invading cells nuclei. For this, use “Image>Adjust>Threshold”, 

select from the drop down menu, and continue to the masking command.  

Note: If prompted before masking, convert the cleared center mass image to 8-bit by clicking 

“Image>Type>8-bit” so as to convert the image into a grayscale format.  

 

 
 
 
 
 
 
 
 
 
 
 
 
 
k. To select area to be analyzed, click “Edit>Selection>Create Selection”. 

 

 

 

 

 

 

 

 

Masked image Hoescht 

Figure 2.3 Binary image of invasive protrusions. Cellular protrusion before and after 
masking.  

Figure 2.4 Selected nuclei. Invasive cellular nuclei before and after selection of area for 
analysis. 

Selected area Masked image 



 35 

l. Measure the area of the selected masked cell nuclei by using the command 

“Analyze>Measure”. The results will be displayed in a pop-up table in the column labelled as 

“Area”. 

 

 

 

 

 

 

m. In addition to nuclear area, the approximate number of invasive nuclei can be determined. 

Keeping the same analyzed masked image opened, proceed to separate and differentiate each 

nucleus by using the commands “Process>Binary>Watershed”. 

n. Click “Analyze>Analyze Particles” and select the appropriate parameters and desired 

output. For the imaging conditions described above, a particle size of 0.01-Infinity works best. 

Select “Summarize” to obtain a table with the results, which will appear under the column 

labelled as “Count”.  

Note: The Size in pixels^2 will change depending on the size of the nucleus of the cells being 

quantified. 

 

 

 
 
 

Figure 2.5 Representative results of nuclear area. Table of results after measuring 
the area of invading cell nuclei.  
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5. Batch analysis  

a. Batch analysis is an unbiased approach to analyze multiple images and add 

reproducibility to the assay. To analyze multiple images in a single run, use the following code, 

composed of each command described above, to create a batch analysis macros.  

setOption("BlackBackground", false); 
run("Convert to Mask"); 
run("Create Selection"); 
run("Measure"); 
run("Watershed"); 
run("Analyze Particles...", "size=0.01-Infinity summarize"); 
 

b. To create a batch analysis macro in ImageJ, start by clicking “File>New>Script”. A 

window will open. This will be your template. 

c. Click “Templates” at the top menu and then click “ImageJ1.x>Batch>Process Open 

Images (IJ1 Macro)”. 

d. Paste the code in line 34 and save the macros. 

Watershed image Nuclei outline 

Figure 2.6 Particle analysis. Nuclear count results of individual nuclei measured as 
separate objects.  
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e. Load all the TIFF images with a cleared center mass on ImageJ and run the code by 

clicking “Batch”.  

f. In the pop up window, upload the images to be analyzed in “Input Files” and for “Which 

input parameters to batch?” choose “Pattern”. 

g. Click ok. Results will be displayed in the two pop-up windows for Count and Area as 

described above. 

 

Figure 2.7 Batch analysis macro. Sample template with the code for an automated 
version of cluster invasion analysis. 
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6. Representative results  

 

a. Depletion of Cdc42, a small GTPase of the Rho family, which regulates actin 

polymerization in cellular protrusions and therefore migration and invasion, decrease invasion in 

multicellular clusters.  

Figure 2.8 Nuclear count and area measurement. Results of cluster protrusion invasion of 
CDC42 knockdown relative to non-targeting control measured by counting number of 
invasive cell nuclei or measuring their area coverage.   
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Protocol for cell aggregates.  Cell aggregates are formed in a single well allowing the formation 

and analysis of multiple spheroids at once as opposed to individual multicellular clusters. 

Combined with circularity analysis, this allows the evaluation of spheroid phenotype in a rapid 

and unbiased way. This approach is useful in determining overall cell morphology as opposed to 

specifically detecting collectively invading cells.  

 

1. Formation of cell aggregates, ECM embedding and staining 

 

a. Plate 200,000-500,000 cells per well in a 24-well ultra-low adhesion plate (Nunc). 

b. Gently shake plate as to distribute cells, then place in a 37˚C incubator for 24-48 h. Do 

not disturb the plate during this time as this may disrupt the aggregation process. 

c. Follow the Cluster embedding into 3-D culture and Immunofluorescence staining 

steps from the “Protocol for clusters” section for embedding in 3-D culture and staining of the 

cell aggregates.  

 

2. Imaging and circularity analysis  

 

a. Imaging was performed using the widefield camera of a Zeiss LSM800 laser scanning 

confocal microscope and widefield camera (Axiocam).  Images were acquired with a 10x 

objective using the Zen Blue software. 

b. Setup the necessary support points throughout the imaging field and adjust the Z position 

in order to adjust the focus onto the desired areas.  
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Note: The Z position is the point at which the sections of the slide will be imaged. Therefore, 

focus in a way to get a sharp image with as much information as possible as blurry images will 

affect the analysis. It is ok to miss some cell aggregates as this form of plating allows for a wide 

field of view with a representative population. 

c. Export images in TIFF format, making sure to save both individual and merged imaging 

channels. 

 

 
 

 

 

 

 

 

 

d. Open the Phalloidin channel TIFF images in the ImageJ software.  

e. Covert to a masked image by using the commands “Process>Binary>Convert to mask”. 

ImageJ often selects a default threshold for masking. If necessary, change it to more accurately 

capture the cell aggregates to be analyzed. For this, use “Image>Adjust>Threshold”, select from 

the drop down menu, and continue to the masking command.  

Note: If prompted before masking, convert the image to 8-bit by clicking “Image>Type>8-bit” 

so as to convert the image into a grayscale format.  

 

 

Hoescht Phalloidin Merged 

Figure 2.9 Representative images of cell aggregates. Exported TIFFs of CZI images for 
analysis including individual nuclear and actin stained channels. 
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f. Smooth the aggregate surfaces as needed in order to avoid fragmented areas that can be 

mistaken as separate aggregates. For this, use the “Process>Binary>Dilate”, 

“Process>Binary>Fill Holes” and “Process>Binary>Close” commands. 

 

 

 

 

 

 

 

 

g. At the top menu bar click “Analyze>Analyze particles” and select the appropriate 

parameters for analysis. For cell aggregates, a particle size of 0.05-Infinity works best, as 

particles of smaller size would not be considered a multicellular aggregates capable of invasion. 

Anything out of this range won’t be analyzed. 

Phalloidin Masked image 

Figure 2.10 Image of cell aggregates in 3-D culture. Cellular aggregates in ECM before 
and after masking. 

Figure 2.11 Binary image of cell aggregates in 3-D culture. Cellular aggregates in 
ECM before and after sharpening the masked image. 

Masked image Sharpened image 
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Note: The Size in pixels^2 will be determined by the experimenter as it can change depending on 

the cells being used, and if analyzing single cells, tumor explants, or cell aggregates. 

h. Keep the circularity range as 0.00-1.00, with 0 being less circular and hence more 

invasive, and 1 being the maximum circularity and less invasive. 

i. Show “Outlines” and click “Summarize” and “Display results”. Click ok and a pop-up 

table will show the results under “Circ.” for the circularity of each individual cell aggregate.  

 

 

 

 

 

 

 

 

 

 

 

 

 

j. For an automated version of the circularity analysis paste the following code in the 

macros template (See the Batch analysis section of the “Protocol for clusters” above). 

setOption("BlackBackground", false); 
run("Convert to Mask"); 
run("Dilate"); 

Figure 2.12 Circularity results. Outlines of cell aggregates analyzed (top) and their 
corresponding circularity measurement (bottom).  

Sharpened image Outlines of cell aggregates  
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run("Fill Holes"); 
run("Close-"); 
run("Analyze Particles...", "size=0.05-Infinity show=Outlines display"); 

 
 

 
3. Representative results  

a. Cell aggregates display diverse invasive phenotypes, with less invasive cells showing a 

circularity closer to 1 and values closer to 0 resulting from increased invasion.  

 

 

 
  

Figure 2.13 Representative results of circularity and their corresponding cell 
aggregates. Circularity measurements reflect the extensive phenotypic heterogeneity 
conferred by distinct tumor cell populations.  

Sharpened image Outlines of cell aggregates  Phalloidin 
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Table 1. List of siRNA sequences 
 
Duplex Catalog 
Number 

Gene Symbol Sequence 

J-047165-05 Ubb GCUAGAAGAUGGCCGCACU 
J-047165-06 Ubb CCGGCAAGCAGCUGGAAGA 
J-047165-07 Ubb CACCUGGUCCUUCGCCUGA 
J-047165-08 Ubb GAUUACAACAUCCAGAAGG 
J-051513-09 Zeb1 UGUAGAUGGUAACGUAAUA 
J-051513-10 Zeb1 GAAAGAGCACUUACGGAUU 
J-051513-11 Zeb1 GCGCAAUAACGUUACAAAU 
J-051513-12 Zeb1 CGGCAUGGCUAGCAGUAUU 
J-059671-05 Zeb2 GAGCAGACAGGCUUACUUA 
J-059671-06 Zeb2 GUAAAUGGCCGAAUGAGAA 
J-059671-07 Zeb2 GCGACACGGCCAUUAUUUA 
J-059671-08 Zeb2 GCAGGUAACCGCAAGUUCA 
J-040704-05 Fosl1 GAACCGGAAGCACUGCAUA 
J-040704-06 Fosl1 AGGCGGAGACCGACAAAUU 
J-040704-07 Fosl1 GAACCUUGCUCCUCCGCUC 
J-040704-08 Fosl1 GCUAAGUGCAGAAACCGAA 
J-043087-09 Cdc42 AUAGAAACGCCUCGAUUAA 
J-043087-10 Cdc42 GAAGGUGGGUGGACGCUGU 
J-043087-11 Cdc42 GGCUGAAGCUUUCGCAAGA 
J-043087-12 Cdc42 GGAUUAUGACAGACUACGA 
J-040706-05 Smad3 GAACUUACAAGGCGACACA 
J-040706-06 Smad3 GGACGCAGGUUCUCCAAAC 
J-040706-07 Smad3 CCAUGGAGCUCUGUGAGUU 
J-040706-08 Smad3 GGAUUGAGCUACACCUGAA 
J-055047-09 Twist1 CCGGAGACCUAGAUGUCAU 
J-055047-10 Twist1 CCCAGCGGGUCAUGGCUAA 
J-055047-11 Twist1 AAUCAUAGUCAGUGAAUUC 
J-055047-12 Twist1 AUUGAUGACCCAUGGUAAA 
J-062765-05 Snai1 UGACCUCGCUGUCCGAUGA 
J-062765-06 Snai1 GAUCUUCAACUGCAAAUAU 
J-062765-07 Snai1 CAAACCCACUCGGAUGUGA 
J-062765-08 Snai1 GCCGGAAGCCCAACUAUAG 
J-042291-05 Snai2 CUAUGAAAGUUACCCUAUA 
J-042291-06 Snai2 GGAUCACAGUGGUUCAGAA 
J-042291-07 Snai2 GGAGCAUACAGCCCUAUUA 
J-042291-08 Snai2 UAAGACCUAUUCUACGUUC 
J-040687-05 Smad4 UCAGGUGGCUGGUCGGAAA 
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Table 1. List of siRNA sequences (cont.) 
 
J-040687-06 Smad4 GAGUGCAGUUGGAAUGUAA 
J-040687-07 Smad4 GCAAUUGAGAGUUUGGUAA 
J-040687-08 Smad4 UCAGUAUGCGUUUGACUUA 
D-001810-01 Non-targeting Control UGGUUUACAUGUCGACUAA 
D-001810-02 Non-targeting Control UGGUUUACAUGUUGUGUGA 
D-001810-03 Non-targeting Control UGGUUUACAUGUUUUCUGA 
D-001810-04 Non-targeting Control UGGUUUACAUGUUUUCCUA 

   
TAQMAN    
Gene Assay ID Gene symbol  
Mm00516876_m1 K14  
Mm00835759_m1 K8  
Mm00495793_m1 Trp63  
Mm00437221_m1 Axl  
Mm01247357_m1 E-cadherin  
Mm99999915_g1 GAPDH  
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Table 2. List of antibodies and stainings 
 

Target 
Catalog 
number  Vendor 

Primary antibodies:   
SV40 554149 BD 
K8 AB-531826 DSHB 
K14 905304 BD 
K14 906001 BioLegend 
EGFR 71655 CST 
pEGFR 3777 CST 
ERK 1/2 9102S CST 
pERK 9106S CST 
deltaNp63 67825S CST 
Vimentin 3922S CST 
Vinculin 13901S CST 
E-cadherin 610182 BD 
Zeb1 NBPI-05987 Novus 
FRA1  sc28310 SC 
pFRA1 5841 CST 
SMAD2/3 8685 CST 
pSMAD2 18338 CST 
cJun 9165 CST 
   
Secondary antibodies:   
Alexa Fluor 488 goat anti-mouse IgG (H+L) A11001 invitrogen 
Alexa Fluor 488 goat       anti-rat IgG (H+L) A11006 Invitrogen 
Alexa Fluor 546 goat anti-mouse IgG (H+L) A11030 invitrogen 
Alexa Fluor 647 goat anti-rabbit IgG (H+L) A21244 Invitrogen 
Alexa Fluor 647 donkey anti-rabbit IgG 
(H+L) A31573 invitrogen 
Alexa Fluor 680 goat anti-mouse IgG (H+L) A21058 invitrogen 
Goat anti-rabbit 800 MT21040CV Thermofisher 
   
Nuclear and cytoskeletal staining:   
Alexa Fluor 546 Phalloidin A22283 Invitrogen 
Alexa Fluor 488 Phalloidin A12379 Invitrogen 
Alexa Fluor 647 Phalloidin A22287 Invitrogen 
Hoechst 33342 H3570 invitrogen 
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Table 3. List of qPCR primers 
 
Name Sequence 
mZeb1 Fwd AGACTATTCTGATTCCCCAAGTG 
mZeb1 Rev CCTTCTGAGCTAGTGTCTTGTC 
mZeb2 Fwd GGAGCTAAGGGAGAGTGTTG 
mZeb2 Rev AATTGTGGTCTGGATCGTGG 
mSnai1/Snail Fwd ACATCCGAAGCCACACG 
mSnai1/Snail Rev GTCAGCAAAAGCACGGTTG 
mSnai2/Slug Fwd AAACATTTCAACGCCTCCAAG 
mSnai2/Slug Rev CAGTAATAGGGCTGTATGCTCC 
mCK8 Fwd TGTTGAGCCCCTTGAAGC 
mCK8 Rev GGTCTCCAGCATCTTGTTCTG 
mCK14 Fwd CAAAGACTACAGCCCCTACTTC 
mCK14 Rev TCTGCTCCGTCTCAAACTTG 
mActin Fwd ATTTCTGAATGGCCCAGGTC 
mActin Rev GCTGCCTCAACACCTCAA 
mFosl1 Fwd ATGTACCGAGACTACGGGGAA 
mFosl1 Rev CTGCTGCTGTCGATGCTTG 
mTWIST1 Fwd CTCAGCTACGCCTTCTCC 
mTWIST1 Rev ACTGTCCATTTTCTCCTTCTCTG 
mVIM Fwd TTTCTCTGCCTCTGCCAAC 
mVIM Rev TCTCATTGATCACCTGTCCATC 
mJUN Fwd GCAGAAAGTCATGAACCACG 
mJUN Rev TCGCAACCAGTCAAGTTCTC 
mCDH1 Fwd CAGGTCTCCTCATGGCTTTGC 
mCDH1 Rev CTTCCGAAAAGAAGGCTGTCC 
mSmad3 Fwd CCGAGAACACTAACTTCCCTG 
mSmad3 Rev CATCTTCACTCAGGTAGCCAG 
mSmad4 Fwd TTGTGACTGTGGATGGCTATG 
mSmad4 Rev CTTCACCTTTACATTCCAACTGC 
mJun_2 Fwd CCTTCTACGACGATGCCCTC 
mJun_2 Rev GGTTCAAGGTCATGCTCTGTTT 
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CHAPTER III. DEFINING MECHANISMS OF INVASION IN THE C3(1)/SV40 TAG 

MOUSE MODEL 

Introduction  

Numerous challenges are encountered during the study and treatment of malignant 

disease due to cancer cell heterogeneity. Therapy failure and patient relapse are in many cases a 

consequence of clinical interventions that fall short of achieving a long-lasting response as a 

result of the changes occurring during tumor evolution [109-111]. For this reason, studying the 

role of the cellular diversity that arises at different stages of cancer disease is of utmost 

important, especially in the context of natural disease progression.  Epithelial-to-

mesenchymal transition (EMT) is believed to be involved in tumor progression due to cells 

adopting mesenchymal properties that allow invasion and local dissemination [19, 70, 71, 73]. 

However, some controversies have arisen in recent years regarding the need for cells to undergo 

a full EMT and lose all epithelial characteristics in order to invade and metastasize [100, 103, 

104]. Additionally, the concept of EMT has shifted and is now believed to comprise a distinct set 

of programs that cannot be explained uniquely by the loss of epithelial character and gain of 

mesenchymal traits or defined by canonical EMT transcription factors [32, 86, 173]. Other than 

recognizing the existence of diverse EMT transition states and the identification of their 

associated markers, few studies have addressed the specific properties of the different 

intermediate EMT states and their functional role in malignant progression [88]. One reason for 

this is the lack of in vitro systems that reliably represent the features of primary tumors, 

hindering our understanding of the distinct EMT state cell subpopulations that can be found in 

heterogeneous tumors and their influence on tumor evolution. Therefore, employing organotypic 

culture and mouse model is useful in evaluating the influence of EMT on collective invasion. 
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However, rapid functional assays for the analysis of organotypic culture are limited. Thus, one of 

my aims with this thesis project was to develop a robust method for analysis of 3-D culture 

invasion that permits a rapid and unbiased approach for investigating invasion.  

To better understand the cellular changes that develop during spontaneous tumor 

formation and evolve throughout malignant progression, I studied the phenotypic and genotypic 

traits of the C3-TAg mouse model of basal type breast cancer [135]. Results of the 

characterization of cell subpopulations encountered here in vivo support our previous findings in 

human-based cell line models which revealed functional interactions between trailblazer and 

opportunist cells [56] The trailblazer EMT state confer cells with an enhance invasive ability and 

is not correlated with canonical markers of EMT [56]. Moreover, contrary to previous reports, 

the activation of a basal program defined by K14 expression [41] was not required in trailblazer 

cells, and in the current work was not necessary to lead collective invasion in C3-TAg tumors 

[56]. 

To better understand the mechanism behind the trailblazer EMT state, I performed RNA 

sequencing analysis followed by functional testing in organoids and cell lines that I derived from 

primary C3T-Ag tumors. Results of these analyses found that the transcription factor Fra1 was 

required for trailblazer cell invasion. Expression of Fra1 has been implicated in the pathogenesis 

of breast, pancreas, lung and colorectal cancers [143, 145, 156, 157, 174]. Fra1 is a downstream 

effector of the ERK1/2 pathway [138] and its expression has been correlated with TNBC [142, 

163]. Importantly, the C3-TAg mouse model represents the basal breast cancer subtype, is 

PR/ER negative and does not overexpress HER2. Trailblazer invasion was induced in response 

to TGFb in C3-TAg cells expressing Fra1. However, this was not explained by changes in Zeb1 

or E-cadherin indicating that TGFb induces a hybrid trailblazer EMT. Overall, the data presented 
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here describes a novel mode of pathway integration indicated by parallel signaling pathways that 

act together to induce rapid trailblazer type invasion of cells that retain epithelial traits. 

 

Results 

An enhanced invasive phenotype in the C3-TAg mouse model does not require the 

activation of basal programs. In order to understand the relationship between cell populations 

with distinct invasive properties in vivo, we sought to determine the extent of heterogeneity 

found in the C3(1)/SV40 Large T antigen (C3-TAg) transgenic mouse model of basal-like breast 

cancer. Organoids obtained from mouse tumor explants plated in 3-D matrices composed of 

Collagen I and Matrigel showed an enhanced invasive capacity of tumors as compared to normal 

mammary tissue (Fig. 3.1A-B). Invasion was defined by the capacity to extend cellular 

protrusions with a leading cell followed by one or more cells in the invasive strand, a feature of 

collective invasion. Importantly, approximately one third of C3-TAg tumor organoids remained 

non-invasive, reflecting the heterogeneous nature of this mouse model (Fig. 3.1B). The 

composition of the ECM can influence invasive properties, as different modes of invasion can be 

detected exclusively in specific Collagen types and percentages [41, 47]. However, the enhanced 

invasive ability of C3-TAg tumors allowed for invasion to occur in a wide range of ECM 

compositions, ranging from the most permissible [47] to the most restrictive (Fig. 3.1C). To 

further demonstrate the existence of distinct invasive characteristics in cell subpopulations of the 

C3-TAg mouse model, we evaluated the invasive properties of tumors at the single cell level. A 

range of invasive phenotypes was observed after tumors were dissociated into single cells and 

small cellular clusters (<5 cells) and allowed to grow in 3-D culture for 4 days, with many 

actively growing organoids having less invasive character, demonstrating that diminished growth 
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capacity was not the cause of reduced invasion (Fig. 3.1D). This indicates that invasive 

heterogeneity in the C3-TAg mouse model occurs as a result of the intrinsic properties of tumor 

cell subpopulations and not as an artifact of tumor processing, or a phenotype requiring cell-cell 

attachments. Motility alone is not sufficient for invasion of breast cancer cells [49, 60, 61]. 

Indeed, live cell imaging showed instraspheroid cell movement in both invasive and non-

invasive organoids, consistent with the idea that a motile phenotype is not sufficient to promote 

invasion (Fig. 3.1E). Similar to the observations in dissociated tumors, reduced fitness was not 

the cause for decreased invasion, as non-invasive organoids did not display reduced motility or 

health (Fig. 3.1F).  
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Figure 3.1 The C3-TAg model posses enhanced invasive abilities and displays ivasive 
heterogeneity. A) Model depicting explant processing and culture. B) Representative images of 
organoids from C3-TAg tumors and normal mammary tissue plated in ECM. Graph shows 
percent of invasive organoids per condition (mean±SEM, n=3 mice per group, unpaired Student’s 
t test). C) C3-TAg organoids invade in different Collagen I/Matrigel percentages. Violin plot 
shows quantification of circularity (Mann Whitney test, n=3 mice). D) Model depicting the 
enzymatic dissociation of C3-TAg organoids. E) C3-TAg organoids cultured for 1 day. 
Dissociated organoids grown for 4 days. Violin plot shows quantification of circularity (Mann 
Whitney test, n=2 mice). F) Still images of C3-TAg organoids acquired during live cell imaging 
for 18h.  

E 

A 
D 

B 

C F 
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Previous research has found that the induction of a basal program is sufficient to promote 

collective invasion [41]. Specifically, expression of the basal cytokeratin K14 was required to 

promote leader cell formation [41]. This prompted us to investigate if K14 expression promotes 

the enhanced invasion observed in C3-TAg tumors. To better understand the properties of the 

different cell subpopulations encountered in primary tumors, we developed clones that represent 

the invasive and non-invasive status of C3-TAg tumor cells. Parental cell lines were derived 

from primary C3-TAg mouse tumors as described in the methods (Chapter II). These parental 

cells were derived from matching tumors explants that were used for organotypic culture assays 

and gene transcription analysis and reflect the heterogeneity observed in tumor organoids by 

displaying variability in invasive phenotype. From here, single cell cloning was used to obtain 

the more epithelial-like non-invasive population, whereas the cell surface tyrosine kinase Axl, 

known to be involved in EMT [175], was used to sort cells of a more mesenchymal character, 

followed by single cell cloning as well (Fig. 3.2A). At least seven different clones from each 

invasive and non-invasive type were derived. Importantly, these clonal cells phenotypically 

correlated with canonical EMT genes patterns of expression (Fig. 3.2B). The mesenchymal-like 

clones display a more invasive character under conditions where epithelial clones remain non-

invasive (Fig. 3.2A). The association of a basal program with leader cell formations and 

collective invasion was detected previously by employing the luminal-type mouse model of 

breast cancer PyMT [41]. In tumor organoids, K14 expression was necessary for leader cell 

formation, and K14 expressing cells lead the collective invasion of cell cohorts in primary 

tumors. However, we found that K14 expression alone did not correlate with invasive behavior 

in C3-TAg-derived clones (Fig. 3.2A). It is possible that invasion is dependent on cancer sub-

type or model-dependent. In addition, collective invasion in this study was only observed on 
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areas enriched with Collagen I [41], whereas C3-TAg explants are capable of invasion in 

different Collagen I percentages as shown in Figure 3.1C, indicating that acquisition of different 

programs may be required in cell-specific microenvironments.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 3.2 Clonal populations derived from the C3T-Ag model represent extreme EMT 
states. A) Representative images of the C3-TAg- derived invasive clone D6 and non-invasive 
clone B6 showing K14 (magenta) and K8 (green) expression. B) Immunoblot showing EMT 
markers E-cadherin, Vimentin and Zeb1 in B6 and D6 clones show the non-invasive population 
display epithelial features and invasive clones have enhanced expression of mesenchymal 
proteins.  
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To further elucidate the role of basal and luminal cytokeratins in promoting collective invasion, 

we wanted to determine the expression patterns of K14 and K8 in cells presenting a leader 

phenotype in C3-TAg organoids. Immunofluorescence analysis revealed that both basal and 

luminal keratin expression can be found in leading invasive cells of C3-TAg tumor explants, as 

shown by a heterogenous pattern of K14 and K8 expression in cells at the leading front of 

collectively invading cell cohorts (Fig. 3.3A). Moreover, C3-TAg organoids were found to 

contain at least three different leading cell populations based on K8 and K14 expression. While 

K14 was expressed in many cells leading invasion, the majority of collectively invading strands 

contained K8 only positive cells as leaders (Fig. 3.3A). Notably, co-expression of K14 and K8 

was also detected in a high percentage of cells at the front of invasive strands (Fig. 3.3A). 

Overall, these data suggest that additional factors are required for invasion in basal-type breast 

tumors. In fact, depletion of K14 only modestly decreased the extent of invasion in cluster 

invasion assays of multicellular spheroids of a C3-TAg-derived cell lines (Fig. 3.3B), indicating 

that K14 expression is not essential for C3-TAg tumor cells to lead collective invasion.  

 
  



 56 

  

A 

B 

Figure 3.3 Induction of a basal program is not required to lead invasion in the C3-TAg 
model. A) K14 (magenta) and K8 (cyan) expression in leading cells of C3-TAg tumor organoids. 
Graph shows percent of keratin expression in leading cells (mean±SEM, n=3 mice). B) Invasion 
in spheroids of C3-TAg-derived cell lines after K14 and K8 depletion. Graph indicates area of 
invading nuclei (mean±SEM, n=2). Unpaired Student’s t test). 
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Basal and luminal proteins can be used to assess the differentiation status of breast carcinoma 

cells [176]. Cytoskeletal proteins like keratins are expressed in a manner specific to the level of 

differentiation consistent with their cells of origin and are routinely used for diagnostic purposes 

in epithelial cancers [176, 177]. In mammary epithelial cells, markers of luminal origin include 

K7, K8, K18 and K19, whereas basal cells express K5, K6, K14 and K17 [176]. Other than to act 

as a marker, K14 has been observed to lead collective invasion in histological samples of mouse 

and human primary tumors [41]. Therefore, we set out to determine if the same pattern of K8 and 

K14 expression observed in organotypic culture can be found in tumor sections. The pattern of 

expression of K8 and K14 was detected by immunostaining in formalin fixed paraffin embedded 

(FFPE) sections of C3-TAg primary tumors (Fig. 3.4A). Similar to our results from C3-TAg 

organoids and cell lines, K8-high/K14- low leading cells were detected in collectively invading 

tumor cell strands (Fig. 3.4A). This indicate that expression of K14 alone in leading cells does 

not correlate with invasive behavior (Fig. 3.4A). These findings suggest that acquiring a basal 

program does not confer invasive properties on their own, and that activation of additional 

programs are necessary for the enhanced invasion observed in C3-TAg tumors. 

  

Figure 3.4 K14-low cells can lead invasion in primary tumors. A) K14 (magenta) and K8 
(white) expression in areas of collective invasion in C3-TAg primary tumors.  

A 
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Trailblazer and opportunist EMT states are found in vivo. Previously we identified a set of 

genes that differentiate two distinct cell populations with different invasive properties in human 

breast cancer cell lines [56]. Trailblazer cells possess an increased invasive capacity, a feature 

that can’t be described solely by a canonical EMT gene signature  [56]. Similarly, trailblazer 

genes were upregulated in C3-TAg-derived invasive clones as compared to their non-invasive 

counterparts (Fig. 3.5A). Trailblazers can also cooperate with their non-invasive opportunist 

siblings, to allow their invasion without the activation of cell-autonomous invasive programs, 

even when a majority of the population are non-invasive cells [56]. The same type of interactions 

were also found between clones of the C3-TAg tumors. When plated as multicellular clusters, 

C3-TAg-derived non-invasive clones retained a spherical phenotype with no cell strands 

extending into the ECM (Fig. 3.5B). In contrast, invasive clones were able to form collectively 

invading strands, and induce non-invasive cells to opportunistically follow (Fig. 3.5B). These 

data indicate that cell subpopulations found in C3-TAg tumors form a relationship characteristic 

of trailblazer and opportunist cells.  

  

A 

B 

Figure 3.5 Trailblazer and opportunist populations are found in the C3-TAg mouse model. 
A) Trailblazer gene expression in C3-TAg clones. B) Spheroids of C3-TAg-derived non-invasive 
B6 (red) and invasive D6 (green) clones. Cells alone or mixed at a 1:1 ratio. Graph shows 
relative number of H2B:mCherry-labeled invading nuclei (mean±SEM, n=3, unpaired Student’s t 
test). 
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Expression of the transcription factor p63 suppresses the trailblazer phenotype, but confers a 

proliferative advantage to opportunist cells [59]. p63 promotes the simultaneous expression of 

epithelial and mesenchymal markers thus inducing motility and opportunistic invasion of cells 

that retain epithelial features [59, 82]. It was further demonstrated that p63-low trailblazer cells 

lead the collective invasion of p63-high opportunists [59]. Overall, these data suggest that a p63-

regulated program controls a hybrid EMT state in opportunist cells which can subsequently 

engage in commensal relationships that could advance diseased progression.  To further confirm 

the existence of trailblazer and opportunist cells in vivo, we determined the patterns of p63 

expression in C3-TAg tumor-derived clones. In the non-invasive epithelial-like clonal cells, p63 

was highly expressed as compared to the more mesenchymal, invasive clones (Fig. 3.6A-B). 

Moreover, these two clonal populations follow an opportunist/trailblazer-like relationship where 

p63-high cells follow p63-low cells into the ECM [56, 59], Fig. 3.6B).  

 

 

 

 

 

 

 

 

 

 

 

Figure 3.6 The trailblazer EMT state suppressor p63 is highly expressed in C3-TAg-derived 
non-invasive clones. A) Immunoblot showing p63 expression in non-invasive and invasive C3-
TAg clones. B) p63 expression restricts invasion while allows B6 cells to opportunistically 
invade behind the p63 low clones D6. 
 

A 

B 



 60 

To further support the finding of trailblazer and opportunist cells in vivo, we next asked if cells 

from freshly digested tumors can promote the invasion of non-invasive clones. For this purpose, 

tumors were dissociated into single cells and formed into multicellular clusters, either alone or in 

combination with non-invasive clones. Immunofluorescence analysis demonstrated that clusters 

from dissociated tumor cells extend protrusions into the Collagen-Matrigel matrix that resemble 

the collectively invading strands observed in clusters from invasive clones and trailblazer cells 

from human cell lines. Moreover, while non-invasive clones did not invade when clustered 

alone, they were induced to opportunistically invade behind invasive cells from fresh C3-TAg 

tumors by following into paths on the ECM created by tumor-derived cells (Fig. 3.7A). 

Importantly, cells leading invasion were consistently p63 low, while p63-high trailed behind 

them (Fig. 3.7A), confirming the trailblazer/opportunist-type commensal behavior where p63-

high cells follow p63-low cells into the ECM. In normal mammary tissue high p63 expression 

was detected in non-invasive areas cells, whereas C3-TAg organoids and primary tumors 

contained p63 low leading cells (Fig. 3.7B-D) [59]. Moreover, increased p63 expression was 

consistently observed in organoids presenting a less invasive phenotype, and invasive strands 

usually contained cells with a low p63 profile (Fig. 3.7E) [59]. Overall, heterogeneous cell 

populations in C3-TAg mouse tumors recapitulate the trailblazer and opportunist cell 

subpopulations found in human TNBC cell lines. Taken together, our findings reveal the 

existence of trailblazer and opportunist cells in the C3-TAg model.  
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Inhibition of TGFb establishes cell lines that retain the properties of primary tumors. 

Based on our observations of the molecular properties and phenotypic characteristics of C3-TAg 

tumors, including expression of E-cadherin and K14 (Fig. 3.8A), we determined that traditional 

approaches for cell line creation and maintenance in culture prevent the establishment of cell 

lines that truly recapitulate the features of this mouse model. In order to obtain a comprehensive 

understanding of EMT state heterogeneity and its effect on tumor progression, we set out to 

establish cell and organoid lines that can be employed for genetic screenings and rapid functional 

testing, while retaining the molecular features and heterogeneity of primary tumors. Our C3T-Ag 

derived clonal cells only represent extreme epithelial and mesenchymal EMT states (Fig. 3.2). 

Similarly, standard culture conditions promote the spontaneous conversion of cells into a 

Figure 3.7 Trailblazer and opportunist populations can be detected in vivo. A) 
Representative images of multicellular clusters of the non-invasive clone B6 (H2B:mCherry) and 
dissociated C3-TAg organoids (unlabeled). Cells clustered alone or mixed at a 50:50 or 10:90 
ratio of C3-TAg:B6. Graph show relative number of invading H2B:mCherry-labeled nuclei 
(mean±SEM, n=3 mice). B) p63 expression in normal mammary epithelial organoids. Graph 
shows quantification of the phenotypes of p63 expressing cells in multicellular protrusions as a 
percentage of total organoids (mean±SD, n=4 mice). C) p63 expression in C3-TAg tumors. 
Graph indicates quantification of the p63-high cell phenotype from at least two 10x fields of 
view at the tumor-stroma interface (mean±SD, n=9 mice). D) Opportunistic invasion of p63-high 
cells in C3-TAg tumor organoids. Graph shows quantification of p63 expression in trailblazer cells as a 
percentage of total organoids (mean±SD, n=4 mice). E) p63 expression in non-invasive C3-TAg 
organoids. Unpaired Student’s t test.  
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mesenchymal state  [178]. For instance, the elements found in serum, including growth factors 

and cytokines, which are essential for cell monolayer attachment and health, can influence 

invasive behavior since high levels of these factors can stimulate the conversion of cells into a 

mesenchymal state [178, 179]. Moreover, due to batch-to-batch variability the exact composition 

of serum at any given time and the concentration of its diverse components can fluctuate limiting 

our control of additional variables during cell line development as well as in experimental 

procedures [179, 180].  Nevertheless, media supplementation with serum have been traditionally 

employed to promote cell growth and survival in culture, as well as 2-D surface attachment  

[179, 180]. In fact, the act of dissociating cells from primary tumors by mechanical disruption or 

enzymatic methods can in and of itself induce cell death [181]. Additionally, inefficiencies 

during the initial steps of cell culture establishment favors the outgrowth of specific cell 

populations, whose nature do not recapitulate the heterogeneity found in the tumor of origin 

[182]. As discussed in Chapter I, induction of a mesenchymal state can be accompanied by a loss 

of cell fitness, and proliferative epithelial cells on the other hand, do not possess intrinsic 

invasive capacity [59]. Moreover, invasive populations can lose K14 expression over time in 2-D 

culture. Notably, maintaining K14 expression during cell culture is crucial, as collective invasion 

in breast cancer models have been associated with K14 and K14-positive cell populations can 

lead invasion in C3-TAg tumors (Fig. 3.3). 

To overcome these challenges, we established a cell line (1863) by the addition of a 

widely used inhibitor of TGFbR1 (A83-01), which prevented cells from acquiring a 

mesenchymal phenotype. The additional culture conditions, adapted from a strategy to develop 

human mammary epithelial organoids [120] (see Chapter II), allowed this cell line to retain 

epithelial properties and K14 expression over time (Fig 3.8B-E). Cells derived from the same 
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tumor using standard culture conditions (see Chapter II), termed 1863T, lost E-cadherin 

expression, displayed increased Vimentin expression, and had an enhanced invasive capacity 

(Fig 3.8B-E). In this way, we derived cell lines from C3-TAg tumors that represent different cell 

phenotypes found in vivo in this model. Importantly, while both cell lines invade in organotypic 

culture, 1863T cells also invade vertically from a monolayer in our vertical invasion assay [56] 

since they are Zeb1 high and posses an enhanced invasive ability, allowing for robust testing 

across multiple assays (Fig. 3.8F).  
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Inhibition of TGFb allows the establishment of organoid lines with properties of primary 

tumors.  While cell line models allow for rapid functional screenings owing to their ease of 

transfection, expansion and versatility in multiple assay, they also have their limitations. Tumor 

organoids better recapitulate the histological and genetic characteristics of primary tumors as 

compared to cell lines and also allow high-throughput screenings, providing an additional tool 

for functional testing [120, 121]. Thus, we established a series of organoid lines derived from 

C3-TAg tumors. The culture conditions, modified from the one used in the creation of the 1863 

cell line [120] (see Chapter II), allowed for the generation and long-term culture of the 1339 

organoid line, derived from a C3-TAg mouse spontaneous tumor (Fig. 3.9A-B). The serum that 

E 
F 

Figure 3.8 Primary tumor cells cultured under TGFb inhibition retain epithelial properties 
and K14 expression. A) Expression of K14 and E-cadherin in C3-TAg primary tumors. B) 
Immunoblot showing differences in E-cadherin and Vimentin expression between 1863 and 
1863T cells. C) The canonical EMT transcription factor Zeb1 is highly expressed in 1863T cells. 
D) E-cadherin expression in 1863 and 1863T cells. E) Immunofluorescent staining shows that 
1863 cells retain K14 expression while K14 is lost in 1863T cells grown in standard culture 
conditions. Representative images show cell spheroids invading at 24 h. F) Model depicting 
cluster invasion and vertical invasion assays.  
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was necessary for attachment of cells in 2-D is not required for our long term 3-D culture method 

and was therefore removed from the media composition, further limiting the influence of 

extrinsic factors that can alter the invasive properties of organoids. Retention of a cohesive 

phenotype was also accomplished by maintaining the organoids in Matrigel and Cultrex (Fig. 

3.9B), which are ECM matrices more restrictive to invasion, as shown in Fig. 3.1C. Using these 

strategies, we were able to study the phenotypic changes conferred solely as a result of the 

treatment under study and only at the time of experimental analysis. Importantly, these culture 

conditions allow for the retention of K14 and other features of primary C3-TAg tumors, such as 

epithelial properties, as was described for 1863 cells in the previous section.  

  

A B 

Figure 3.9 C3-TAg tumor organoids grown under TGFb inhibition and in 3-D culture 
retain features of primary tumors. A) Workflow of the development of organoid lines from 
C3-TAg tumors. B) Representative image of organoids plated in Cultrex matrix for 24 h.  
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Microenvironmental factors increase phenotypic heterogeneity and enhances invasion. It is 

widely recognized that extrinsic factors secreted by stromal or immune cells can modulate gene 

expression as well as phenotype in highly plastic cells [183-185]. Although we have shown that 

ECM composition is sufficient to allow the relative invasion of cells in different EMT states, our 

aim to develop a comprehensive approach for the study of EMT requires the inclusion of 

extracellular cues secreted by cells that shape the tumor microenvironment. In fact, the distinct 

invasive traits of C3-TAg-derived cell lines grown with or without TGFb inhibition indicate that 

external stimuli exert a significant effect in C3-TAg cell phenotype, consistent with numerous 

reports [63, 85]. Cells with active TGFb pathway signaling during time in culture gained 

mesenchymal features including an enhanced invasive ability, demonstrating the potential of 

TGFβ to induce a trailblazer (Fig 3.8). A similar adoption of canonical mesenchymal properties 

was observed in the invasive D6 clone that was also derived in the absence of a TGFbR inhibitor 

(Fig 3.2). Moreover, the differential expression of the canonical EMT transcription factor Zeb1 

between these two cell lines indicate that TGFb can modulate its expression which can in turn 

influence the extent of EMT and invasion. TGFβ is a canonical inducer of EMT and Zeb1 its 

upregulated in response to TGFb [62, 186]. Additionally, the levels of cancer associated 

fibroblasts and immune cell infiltration correlate with an increase in Zeb1 and Zeb2 in human 

and mouse tumors [32]. Both fibroblasts and macrophages secrete TGFb, among other growth 

factors [169]. 

In an effort to create a comprehensive test platform that faithfully recapitulate the effects 

of tissue architecture, cell intrinsic properties and cell extrinsic factors on invasion, we tested the 

influence TGFb exposure on the C3-TAg-derived cell and organoid lines. Treatment with 

soluble TGFb in the absence of TGFbR1 inhibitor enhanced the invasion of 1339 organoids (Fig. 
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3.10A).  Similarly, invasion of 1863 cell clusters into ECM was increased after addition of TGFb 

(Fig. 3.10B). Importantly, this enhanced invasion was observed 48 h after TGFb addition, 

suggesting that TGFb signaling can rapidly modulate the invasive properties of C3-TAg tumor 

cells, consistent with the enhanced invasion we observed in explants and trailblazer cell 

subpopulations of C3-TAg tumors. Thus, factors from the microenvironment can potentially 

promote the rapid invasion of cells in different EMT states, making our cell and organoid line 

study system a reliable model for studying the regulation of the trailblazer EMT state. The role 

of TGFb pathway activity in promoting invasion in the C3-TAg model was further confirmed 

when treatment with two distinct TGFbR inhibitors restricted the invasion of 1339 organoids 

(Fig. 3.10A). Similarly, TGFbR inhibition dramatically reduced the invasion of freshly digested 

C3-TAg tumor organoids (Fig. 3.10C).  

  
A 



 69 

  

B 

C 

Figure 3.10 TGFb pathway activity modulates the invasion of C3-TAg tumors. A) A83-01 
(500nM) and SB43152 (1 uM) suppress both intrinsic and TGFb (2ng/mL) induced invasion of 
organoid lines. Violin plot shows quantification of circularity (Mann Whitney test, n=2 for 
SB43152, n>4 for A83-01). B) Representative images of 1863 spheroids treated with or without 
2 ng/mL TGFb for 48 h.  Graph shows area of invading nuclei relative to control (mean±SEM, 
n=2, unpaired Student’s t test). C) Model showing C3-TAg explant processing and treatment. 
A83-01 reduces the invasion of C3-TAg organoids. Violin plot shows area of invading nuclei 
(Mann Whitney test, n=3 mice). 
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Next, we wanted to detail the molecular mechanisms induced by TGFb to promote trailblazer 

activity in C3-TAg cells.  In the canonical TGFb pathway, TGFβ induces gene expression 

changes by promoting the TGFbRI-dependent phosphorylation of the transcription factors 

SMAD2 and SMAD3, which interact with the co-factor SMAD4, regulating target genes [63, 

187]. However, TGFb also perform non-SMAD pathway functions involving various branches 

of MAP kinase, Rho-like GTPase and phosphatidylinositol-3-kinase/AKT signaling pathways, 

among others [188]. Therefore, we wanted to determine if the observed TGFβ induced invasion 

in our model system occurred through the canonical activity of TGFb. Depletion of SMAD3 

decreased the TGFb-induced invasion of 1863 spheroids (Fig. 3.11A-B), indicating that a TGFβ 

regulated gene expression program contributed to the observed trailblazer EMT. Additionally, 

SMAD3 depletion reduced the vertical invasion of 1863T cells, with similar results observed 

using 2 distinct siRNAs, showing that these cells also retained a requirement for TGFβ pathway 

activity (Fig. 3.11C-D).  
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Induction of EMT by TGFβ can involve suppression of miR200 family of miRNAs, which are 

known to suppress the canonical EMT transcription factors Zeb1 and Zeb2  [91, 189]. Consistent 

with these reports, transfection with a miR200 mimic depleted Zeb1/2 expression in 1863 cells 

(Fig. 3.12A). Moreover, ectopic miR200 expression reduced the invasion of 1863T cells in both 

vertical invasion and cluster invasion assays (Fig. 3.12B-C). Similarly, miR200 expression 

suppressed the TGFb-dependent invasion of 1863 cell clusters (Fig. 3.12D). These data suggest 

that the invasive properties of trailblazer EMT cells can be regulated at least in part by the core 

EMT transcription factors Zeb1 and Zeb2.  

  

Figure 3.11 Canonical TGFβ signaling modulates the rapid invasion of C3-TAg tumor 
cells. A) qPCR showing SMAD3 siRNA reduces SMAD3 expression (mean±SD, n=3). B) 
Model showing cluster invasion assay. SMAD3 depletion suppresses the invasion of C3-TAg-
derived cell lines plated in ECM as multicellular clusters and treated with 2 ng/mL TGFb 
(mean±SEM, n=2). C) SMAD3 silencing suppresses vertical invasion (mean±SEM, n=3). D) 
Vertical invasion is suppressed by separate SMAD3 siRNA sequences (mean±SEM, n=3). 
Unpaired Student’s t test. 
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Figure 3.12 miR200 restricts TGFβ-induced invasion of C3-TAg cells by suppressing Zeb1 
and Zeb2. A) miR200c-3p suppresses Zeb1 and Zeb2 expression (mean±SEM, n=2). B) 
Vertical of invasion of 1863T cells is suppressed after expression of miR200c-3p (mean±SEM, 
n=2). C) Expression of mir200c-3p reduces the invasion of 1863T spheroids. Graphs shows area 
of invading nuclei (mean±SEM, n=2). D) miR200c-3p decreases invasion of 1863 cell lines 
plated in ECM as multicellular clusters in media containing 2 ng/mL TGFb (mean±SD, n=2). 
Unpaired Student’s t test. 
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To support these findings, we further tested the potential role of Zeb1 and Zeb2 in modulating 

the trailblazer EMT state in C3-TAg derived cells. Consistent with the reduced invasion 

observed in cells in which ZEB1/2 are suppressed by exogenous miR200, simultaneous depletion 

of Zeb1 and Zeb2 restricted the vertical invasion of 1863T cells and the mesenchymal-like C3-

TAg derived invasive clone D6 (Fig. 3.13A-B and D). The combined silencing of Zeb1 and Zeb2 

also reduced TGFb-induced invasion of 1863 spheroids (Fig. 3.13C-D). In contrast, additional 

canonical EMT transcription factors, namely Snail, Slug and Twist, did not significantly 

decreased invasion (Fig. 3.13E). Taken together, our data indicates that Zeb1 and Zeb2 

expression are necessary to induce a trailblazer EMT state.  
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Figure 3.13 Zeb1 and Zeb2 are necessary to induce a trailblazer EMT. A) Combined 
depletion of Zeb1 and Zeb2 reduces the vertical invasion of 1863T cells (mean±SEM, n=3). B) 
Combined depletion of Zeb1 and Zeb2 reduces the vertical invasion of the invasive clone D6 
(mean±SEM, n=3). C) Simultaneous depletion of Zeb1 and Zeb2 reduces the TGFb-induced 
invasion of spheroids of 1863 cells. 2ng/mL TGFb added at the time of ECM plating. 
(mean±SEM, n=3). D) qPCR showing Zeb1 and Zeb2 depletion after siRNA-induced 
knockdown  (mean±SEM, n=2). E) Depletion of canonical EMT markers Snail, Slug and Twist 
does not alter the invasion of 1863T cells (mean±SEM, n=2). Unpaired Student’s t test. 
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The TGFb pathway promotes expression of Zeb1/2 and other EMT transcription factors 

which induce Vimentin and suppresse E-cadherin to confer a mesenchymal phenotype [86, 187]. 

In 1339 organoids, Vimentin expression was increased within 48 h of TGFβ treatment, 

suggesting the activation of a mesenchymal expression program (Fig. 3.14A). 

Immunohistochemical analysis of primary C3-TAg tumors revealed that Vimentin expressing 

cells lead invasion at the tumor stromal boundary, consistent with EMT activation in collectively 

invading cells in the C3-TAg model (Fig. 3.14B). However, expression of additional canonical 

EMT markers remained unaltered, including Zeb1 and Zeb2 (Fig. 3.14A). Moreover, expression 

of E-cadherin was retained during TGFb exposure (Fig. 3.14A). It has been shown that cells can 

transition to a stable EMT state after one hour of TGFb treatment [186]. This brief exposure to 

TGFbb was sufficient to switch cells to a stable E-cadherin low and Vimentin high state and 

acquire a mesenchymal phenotype independent of TGFbR activity [186]. In contrast, our 

findings suggest that a trailblazer state in C3-TAg tumor populations does not necessarily require 

a stable switch to a fully mesenchymal state or independence from TGFbR1 activity. Taken 

together, our results indicate that TGFβ induces the rapid invasion of cells while remaining in a 

hybrid EMT state. Notably, hybrid EMT activation is detected in subpopulations of triple-

negative breast tumors (Fig. 3.14C), highlighting the importance of defining the function of cells 

in distinct EMT states.  
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Figure 3.14 TGFβ  induces the rapid invasion of cells that retain epithelial features. A) 
Canonical EMT marker expression after 48 h of TGFβ  treatment (mean±SEM, n=2). B) VIM 
expression in areas of collective invasion in C3-TAg primary tumors. C) Expression of 
Vimentin, E-cadherin and K14 in TMAs of triple-negative breast patient tumors indicate a 
hybrid EMT can be active in collectively invading patient tumor cells (n=50). 
 
 
 
 
 
 
 



 77 

We have shown how TGFβ induces the rapid invasion of cells that retain epithelial features. In 

an effort to elucidate how is a stable invasive state that is characteristic of trailblazer cells in 

human breast cancer cell lines and observed in 1863T cells induced during tumor progression, 

we investigated the effects of persistent exposure to TGFb on cells in a hybrid EMT state. We 

performed syngeneic studies using the REAR mouse model, to allow the retention of an intact 

immune system during our experiments [171]. In these mice only one copy of the C3(1)/Tag-

antigen is expressed, rendering them unable to form spontaneous tumors while making the 

mouse tolerant to transplantation of our C3-TAg organoid lines [171]. Tumors that develop from 

1339 organoids after orthotopic injection displayed heightened invasive characteristics as 

compared to the 1339 organoid line itself, consistent with TGFβ in the microenvironment 

inducing a trailblazer EMT in vivo (Fig. 3.15A). Similarly, TGFb-induced invasion increased 

with long term exposure (Fig. 3.15B). Further supporting this finding, canonical EMT markers 

tested during sustained TGFb exposure were not changed in manner that will be consistent with 

cells progressively transitioning towards a full EMT, but rather retained distinct patterns of 

expression more in accordance with a spectrum of hybrid EMT states (Fig. 3.15C). This indicate 

that TGFβ modulates the conversion of cells into distinct EMT states which include a trailblazer 

EMT.   
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Figure 3.15 TGFβ modulates the transitions to distinct EMT states without loss of E-cadherin. 
A) Model of organoid line processing before and after orthotopic injection. Transplanted organoids 
display enhanced invasion as compared to organoids kept in culture (mean±SEM, n=3 mice, 
unpaired Student’s t test). B) Representative images of organoid lines at different times of TGFβ 
exposure. Graph shows circularity quantification (Mann Whitney test, n=2). C) Expression changes 
of EMT markers at different times of TGFβ exposure (mean±SD, n=2). 
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Fra1 promotes the invasion of cells in a hybrid EMT state without modulation of Zeb1 

expression and in parallel to TGFb signaling. To better understand the signaling networks that 

confer an invasive phenotype in basal-like tumors, we wanted to determine what genes are 

differentially expressed between invasive and non-invasive C3-TAg tumor cell populations. For 

this purpose, we performed RNA sequencing and analyzed the gene expression profiles of C3-

TAg tumor explants and non-invasive clones grown in 3-D culture to allow the analysis of 

populations after they have acquired their invasive phenotype (Fig. 3.16A). A mammary 

adenocarcinoma cell line (M6) derived from the C3-TAg model [174], which retains a non-

invasive phenotype in 3-D culture was also employed (Fig. 3.16B). In addition, RNA from 

parental cell lines derived from the tumor explants analyzed and cultured as monolayer was 

submitted for analysis. Results of this transcriptional analysis show upregulation of YAP/TAZ 

target genes, chemokines and growth factors involved in the TGFb pathway, and the EMT 

inducing transcription factors Zeb1 and Zeb2 in invasive samples as compared to non-invasive 

cells (Fig. 3.16A). In addition, various transcription factors known for their role in tumor 

development were differentially expressed between samples, including p63 (Fig. 3.16A).  To 

further support this data, we validated the expression of some of these genes in additional tumors 

obtained from C3-TAg mice and grown in ECM (Fig. 3.16C). To evaluate requirements for 

invasion, we prioritized genes to be functionally tested, based on their status as members of 

canonical pathways involved in TNBC initiation, invasion, and progression that were highly 

expressed in our invasive explants or cell lines.   
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Figure 3.16 Differentially expressed genes in C3-TAg invasive organoids and non-invasive 
cells grown in organotypic culture. A) Heatmap of differentially expressed genes in C3-TAg 
explants (ms1-4), C3-TAg non-invasive clones (B6, C6, E8) and M6 cells. B) Representative 
image of M6 cells grown in ECM. C) Expression of selected genes from the RNAseq results was 
validated in additional C3-TAg tumor organoids.  
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Selected candidate genes were functionally validated using a gene silencing approach. Using this 

siRNA screening in vertical invasion as well as in 3-D cluster invasion assays, we determined the 

invasive ability of 1863 and 1863T cells after transfection with siRNAs towards the selected 

gene targets. This functional testing revealed many of the candidate genes were able to decrease 

invasion, however, prioritization was given to those that reduced invasion by at least 50 percent 

(Fig. 3.17A-B).  
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Figure 3.17 The transcription factor Fra1 is required for C3-TAg trailblazer invasion. A) 
The relative invasion of 1863T cells ≥40 μm into the ECM. The number of invasive cells is 
normalized to the total cell number in the field of view. Relative invasion is the normalized 
invasive cell number divided by the average normalized invasive cell number of the control 
wells (mean±SEM, n=2). B) Representative images of 1863 multicellular clusters after Fra1 
depletion. Clusters invading in ECM under media containing 2 ng/mL TGFb.  Graph depicts 
area of invading nuclei relative to control (mean±SD, n=2). C) Depletion of Fra1 decreases the 
invasion of 1863T spheroids. Graphs shows area of invading nuclei (mean±SEM, n=2, unpaired 
Student’s t test). D) Fra1 mRNA is depleted after silencing using two separate Fra1 siRNA pools 
(mean±SEM, n=3 for pool 1 and n=2 for pool 2). Unpaired Student’s t test. 
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Using this threshold, we found that the AP-1 family member FOS-like antigen 1 (Fosl1) gene, 

also known by its protein product, the Fos-related antigen 1 protein (Fra1), was consistently 

required for invasion in 1863T cells, as wells as the TGFb-dependent invasion of 1863 cell 

clusters (Fig. 3.17A-D). Four individual non-overlapping siRNA sequences targeting Fra1 

recapitulated the decrease in vertical invasion of 1863T cells (Fig. 3.18A). A second Fra1 siRNA 

pool also suppressed the vertical invasion of 1863T cells and D6 clones (Fig. 3.18B-C and 

3.17D).  
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Figure 3.18 Fra1 suppression restricts C3-TAg invasion. A) The four individual sequences 
from Fra1 siRNA pool 1 restricts vertical invasion in 1863T cells (mean±SEM, n=3). B) An 
additional Fra1 siRNA pool suppresses the vertical invasion of 1863T cells (mean±SEM, n=4). 
C) Depletion of Fra1 also reduces the vertical invasion of the invasive clone D6 (mean±SEM, 
n=3). Unpaired Student’s t test.  
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The AP-1 transcription factor has been implicated in tumorigenesis and Fra1 in particular 

is associated with increased cell motility, enhanced invasion and progression to metastasis [145, 

155, 163, 190-192]. Similarly, increased Fra1 expression correlated with an invasive phenotype 

in our C3-TAg-derived study system. For instance, upregulation of Fra1 was detected in C3-TAg 

tumors as compared to normal mammary mouse tissue (Fig. 3.19A). Increased Fra1 expression 

was also observed in C3-TAg-derived invasive clones when compared to their non-invasive 

counterparts (3.19B), consistent with the role of Fra1 in modulating invasion.  

  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Fra1 is a member of the Fos family of basic leucine Zipper domain proteins that form 

heterodimers with Jun proteins to produce the transcription factor, activator protein 1 (AP-1) 

[192]. To support the role of Fra1/AP-1 in C3-TAg invasion, we also tested the invasive ability 

of cells after depletion of the Fra1 binding partner cJun. As expected, depletion of the cJun 

protein using an siRNA pool as well as its four separate sequences decreased invasion in 1863T 

cells at a level comparable to that of Fra1 depletion (Fig. 3.20A-B and 3.20D). Expression of 

cJun was increased in invasive clones (Fig. 3.19B), and cJun was required for invasion in D6 

A B 

Figure 3.19 Fra1 is upregulated in invasive C3-TAg cell subpopulations. A) Fra1 mRNA is 
upregulated in C3-TAg tumors relative to normal mammary tissue. B) qPCR of Fra1 and cJun 
expression in C3-TAg-derived clones. 
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clones as well (Fig. 3.20C). These findings implicate AP-1 signaling in the invasive phenotype 

displayed by cells in a trailblazer EMT state.  

  

C 

D 

A B 

Figure 3.20 Depletion of the Fra1 binding protein cJun reduces the invasion of C3-TAg 
derived cells. A) Depletion of the Fra1 binding partner cJun decrease vertical invasion in 1863T 
cells (mean±SEM, n=3). B) Invasion is decreased after transfection with the four individual 
sequences from cJun siRNA pool in 1863T cells (mean±SEM, n=3). C) Silencing of cJun 
suppresses the vertical invasion of D6 clones (mean±SEM, n=3). D) qPCR of cJun mRNA after 
siRNA-induced gene knockdown (mean±SEM, n=2). Unpaired Student’s t test. 
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Signaling by Fra1/AP-1 has been implicated in tumor associated EMT in human breast 

cancer. In mouse derived mammary epithelial cell lines, Fra1 induced a full EMT state through 

modulation of Zeb1 and Zeb2 expression by direct binding of their promoters and other 

regulatory gene regions [155]. In this previous report, exogenous overexpression of Fra1 lead to 

induction of a mesenchymal state in epithelial mouse cells, correlating with a Zeb1 and Zeb2 

molecular signature  [155]. However, silencing of Fra1 did not lead to a decrease in Zeb1 and 

Zeb2 expression in our model, indicating that Fra1 regulates the trailblazer EMT state without 

modulating Zeb1/2 (Fig. 3.21A). We have shown that Zeb1 and Zeb2 are required for the 

invasion of cells in distinct EMT states, including cells that retain epithelial properties. In 

addition, invasion of cells in a hybrid EMT is potentiated by TGFb pathway activity.  However, 

Fra1was not regulated by TGFβ signaling, as acute TGFβ stimulation nor TGFbR inhibition 

altered Fra1 expression (Fig. 3.21B-C), indicating that Fra1 promotes invasion by a signaling 

mechanism that functions in parallel to TGFb activity. Overall, our findings reveal that TGFb 

and Fra1 activities induce parallel signaling programs that regulate the trailblazer EMT state in 

basal-type tumors. 

  C A B 

Figure 3.21 Fra1 is not regulated by TGFb and does not modulate Zeb1 and Zeb2 in the C3-
TAg model. A) qPCR showing how Fra1 depletion does not alter Zeb1 and Zeb2 expression in 
C3-TAg tumor cells (mean±SD, n=2). B) qPCR showing that TGFb treatment (2ng/mL for 48 h) 
does not alter the expression of Fra1 in 1339 organoids (mean±SD, n=2). C) qPCR results 
showing how suppression of the TGFb pathway does not influence Fra1 expression (mean±SD, 
n=2). 
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ERK pathway activity allows sustained Fra1 expression and TGFb enhancement of Zeb1-

dependent invasion. The crosstalk between distinct signaling networks increases cancer 

heterogeneity as cells in different degrees of EMT can differentially respond to environmental 

factors arising during disease evolution.  This is the case for basal-like breast tumors, as shown 

in the C3T mouse model of basal-type breast cancer. Here, we have found that between TGFb  

and Fra1, pathway crosstalk promotes cancer cell heterogeneity in response to AP-1 signaling 

and induces a trailblazer EMT state. In order to understand the role of Fra1 in the regulation of 

TGFb  -induced trailblazer EMT state in the C3T model, we wanted to investigate the 

mechanisms that control Fra1 expression. The transcription factor AP-1 is a downstream effector 

of the ERK1/2 signaling pathway [138, 142]. In fact, Fra1 expression and stabilization are 

dependent on ERK activity, with base levels required for transcription while sustained signaling 

promotes phosphorylation and protects Fra1 against proteasome degradation [138, 142]. The 

activity of ERK is due upon its phosphorylation status conferred by a cascade of upstream 

signals following the activation of receptor tyrosine kinases after exposure to different growth 

factor ligands, including FGF1/2 and EGF [139-141]. Basal-like breast cancers have an activated 

EGFR gene signature relative to other breast cancer subtypes [58], and often overexpress EGFR 

[193]. In fact, we have previously shown that ERK is involved in the induction of motility of 

breast cancer cells, particularly in cells that express p63 [49] and that are capable of fibroblast-

led invasion. These cells retain both epithelial and mesenchymal markers that simultaneously 

allow invasion and proliferation, arguably conferring an advantage in cancer disease progression 

[49]. 

In line with previous data, we detected increased levels of phosphorylated ERK1/2 in 

collectively invading cells in C3-TAg primary tumors, indicating that the ERK1/2 signaling 
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pathway is activated in basal-like breast cancer models (Fig. 3.22A). The activity of ERK1/2 is 

influenced by negative feedback loops and can thus cycle in response [194]. It is possible that for 

this reason, sustained phosphorylation is not always detected in all collectively invading cells. 

Nevertheless, our data suggests that ERK1/2 may be part of a molecular program that enhances 

invasion in C3-TAg tumor cells.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Consistent with the role of ERK1/2 in modulating Fra1 and invasion, pharmacological inhibition 

of MEK1/2, which prevents ERK1/2 activation, suppressed TGFb-induced invasion of 1339 

organoids, (Fig. 3.23A). Notably, MEK1/2 inhibition also suppressed the invasion of explants 

derived from four different C3-TAg mouse tumors (Fig. 3.23B). Importantly, while inhibition of 

MEK1/2 signaling suppressed ERK1/2 phosphorylation and reduced Fra1 protein levels, it did 

not alter Jun expression, showing that ERK1/2 specifically regulates Fra1 (Fig. 3.23C). 

Moreover, MEK1/2 inhibition did not alter the phosphorylation status of SMAD2 or the 

A 

Figure 3.22 Activated ERK1/2 is detected in C3-TAg primary tumors. A) Phosphorylated 
ERK1/2 (magenta) in C3-TAg primary tumor sections. Tumor cells indicated by expression of 
SV40 (cyan) and K8 (white). 
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expression of Zeb1, indicating that ERK1/2 inactivation restricts invasion without affecting 

TGFβ pathway activity (Fig. 3.23C), supporting the idea that TGFb and Fra1 signaling programs 

work in parallel to promote trailblazer type invasion. 

  

A 

C B 

Figure 3.23 The activity of ERK1/2 is required for Fra1 expression and the induction of a 
trailblazer EMT state. A) Representative images of organoid lines invading in ECM under 
TGFb treatment with or without Trametinib (50 nM). Violin plot shows quantification of 
circularity (Mann Whitney test, n=4). B) Invasion of fresh C3-TAg organoids is reduced after 24 
h of Trametinib (50 nM) treatment. Violin plot shows quantification of area of invading nuclei 
(Mann Whitney test, n=4 mice). C) Upper immunoblot shows Fra1 and phosphorylated Fra1 
protein expression in 1339 organoids treated with 50 nM of Trametinib. ERK1/2 phosphorylation 
is reduced upon treatment. Lower immunoblot shows MEK1/2 inhibition by Trametinib does not 
alter the expression of canonical EMT markers (n=2). 
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Ligand activation of growth factor receptors can induce the phosphorylation of ERK1/2 2 [138, 

195, 196]. Activating ligands include growth factors such as EGF, AREG, EPGN and HBEGF 

that can be secreted by cellular components of the tumor microenvironment or by cancer cells in 

an autocrine signaling manner [197-200]. Notably, AREG, EPGN and HBEGF gene expression 

was upregulated in C3-TAg organoids as compared to non-invasive cells (Fig. 3.16). 

Additionally, overexpression of receptor tyrosine kinases can lead to their activation via ligand 

independent mechanisms. For instance, HER2 amplification can activate ERK1/2 and synergize 

with TGFβ pathway activity to promote invasion [58]. HER2 amplification is not observed in 

C3-TAg tumors suggesting that autocrine signaling promotes ERK1/2 activation in C3-TAg cell 

and organoid lines. Indeed, EGFR pathway suppression by the EGFR inhibitor Erlotinib 

decreased Fra1 expression, similar to what is observed after MEK1/2 inhibition (Fig. 3.24A). 

Consistent with a restriction of Fra1 activity, suppression of TGFb-induced invasion was 

observed in 1339 organoids treated with Erlotinib for 48 hrs (Fig. 3.24B). In addition, inhibition 

of TGFb drastically reduced the EGF-induced invasion of 1339 organoids (Fig. 3.24C), in line 

with our findings demonstrating that TGFb and Fra1 support distinct regulatory programs that 

permit trailblazer invasion.  

  

A 
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Figure 3.24 TGFβ  and Fra1 induce parallel signaling programs to regulate the trailblazer 
EMT state. A) qPCR showing how inhibition of ERK1/2 and EGFR activity suppresses Fra1 
expression (mean±SD, n=2). B) Treatment with the EGFR inhibitor Erlotinib (1 uM) decreases 
the TGFβ -induced invasion in organoid lines. Violin plot shows quantification of circularity 
(Mann Whitney test, n=4). C) Representative images showing that A83-01 (500 nM) treatment 
suppresses the EGF-induced invasion of 1339 organoids. Violin plot shows circularity 
quantification (Mann Whitney test, n=2). 
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Discussion 

To summarize this chapter, I have investigated the molecular mechanisms necessary for 

invasion in primary tumor cells. My findings reveal that parallel signaling programs can 

modulate cell intrinsic properties and response to external cues, conferring cells in a hybrid EMT 

state the ability to initiate collective invasion. While it is broadly recognized that cancer cells can 

exist in distinct EMT intermediate states, their contributions to disease progression remains 

unclear [85, 88, 92, 201, 202]. In fact, the involvement of EMT itself in metastasis has been 

widely debated [100, 103, 104]. Nevertheless, it is generally accepted that cancer cells that 

undergo EMT acquire migratory properties that promote invasion and local dissemination [63, 

86, 97, 203]. As the term suggests, the loss of epithelial properties, such as reduction in E-

cadherin and cell-cell contacts, has been historically used for the assessment of EMT [62, 74, 75, 

203]. Further acquisition of mesenchymal features, which allow ECM remodeling and local 

invasion, explains how solitary cells would migrate from the primary tumor to a distant site [34, 

62, 204]. However, this model of EMT-induced single cell invasion cannot explain the 

observation that in most primary tumors invasive populations collectively invade, as defined by 

cells that invade as a group, keeping cell-cell contacts intact [34, 205, 206]. Thus, the focus on a 

highly mesenchymal phenotype triggering invasion opposes the numerous reports identifying 

that collective mode of invasion is the most commonly form of dissemination employed by cells 

in solid tumors [45-47]. Moreover, tumor cells retaining E-cadherin expression possess 

migratory potential, can have properties such as enhanced motility and are capable collective 

invasion [59, 176]. Co-expression of epithelial and mesenchymal genes have also been detected 

in invasive populations [32, 83, 84, 93], supporting the notion that EMT is best characterized by 

a collection of distinct cellular states. This challenges our conceptual understanding of EMT as a 
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binary event with a single, fully mesenchymal outcome and raise two important questions: 1) 

What additional programs not defined by the expression of canonical epithelial and 

mesenchymal markers control the conversion to different EMT states? and 2) What functions 

does distinct cell EMT identities have in disease progression? 

In order to answer these questions, my work has centered in the investigation of the 

factors that regulate the conversion to a trailblazer EMT state. Previous work using human breast 

cancer cell line models uncovered that trailblazer cells possess a unique ability to reorganize the 

ECM and initiate collective invasion [56]. In addition, ECM microtracks created by trailblazer 

cells promote the invasion of opportunist siblings that while motile, do not possess intrinsic 

invasive abilities [56, 59]. We have begun to characterize the factors that distinguish trailblazer 

and opportunist cell subpopulations [56, 59]. Interestingly, while we do observe expression 

patterns consistent with the activation of an EMT signature, canonical EMT markers alone 

cannot distinguish between a trailblazer and opportunist phenotype [56]. However, expression of 

EMT related genes is necessary for trailblazer invasion albeit not sufficient to induce a trailblazer 

state [56]. Therefore, trailblazer and opportunist are two distinct EMT states.  

Further analysis revealed that the basal transcription factor p63 suppresses the trailblazer 

phenotype and induces motility in opportunist cells, allowing them to collectively invade behind 

leading trailblazer cells while retaining epithelial features [59]. Importantly, p63 expression 

confers a proliferative advantage to opportunist cells [59]. Therefore, interactions between cell 

populations in different EMT states can have the potential to promote disease progression. In 

fact, EMT and non-EMT cells have been detected in circulating tumor cell clusters [207, 208], 

and cells with epithelial character where induced to metastasize by commensal interactions with 

cell in a complete EMT [209]. For one, ECM rearrangements by intrinsically invasive trailblazer 
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cells provides a way in which non-invasive opportunist siblings can escape a benign lesion [56, 

59]. This type commensal relationship permits intrinsically non-invasive cells to circumvent the 

need for molecular events that would regulate a conversion to an invasive state  [96, 209]. 

Possibly, if these populations were to exist in vivo, their way of cooperation can promote an 

earlier progression to metastasis. Notably, even rare trailblazer populations can induce p63-high 

cells to opportunistically invade [56, 59]. This means that a cell subpopulation with epithelial 

traits can disseminate throughout the body by the action of intrinsically invasive cells and 

proliferate once they reach a distant site. This scenario is consistent with reports of metastatic 

dissemination with no signs of EMT, metastatic lesions with epithelial traits and invasion of cells 

in a hybrid EMT state [99, 103]. 

The data presented in this chapter shows that trailblazer and opportunist populations are 

found in primary C3-TAg mouse tumors. In line with our previous findings [56, 59], the 

phenotypically distinct populations derived from C3-TAg tumors engaged in cooperative 

interactions, where highly invasive cells induced the invasion of motile, non-invasive cells that 

display epithelial characteristics such as high E-cadherin expression and decreased Zeb1. This 

was not only uncovered using clonal populations representing two extreme EMT states that were 

established from C3-TAg tumors, but in freshly derived primary tumor cells. As such, this is the 

first report of the existence of trailblazer and opportunist cell subpopulations in vivo. Confirming 

this finding, my work revealed that similar to our previous reports, p63 signaling was part of a 

suppressive program that restricts the invasive trailblazer EMT state. Moreover, p63-high C3-

TAg-derived cells opportunistically invaded behind p63-low C3-TAg populations.  

In an effort to define the signaling programs that confer a trailblazer phenotype, I next 

evaluated the specific molecular properties of invasive C3-TAg tumor cells. Studies employing 
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the polyoma middle T antigen (PyMT) mouse model, a breast cancer model that is representative 

of the human luminal breast cancer subtype, determined that the acquisition of a basal program 

defined by K14 and p63 is sufficient to induce collective invasion [41]. The expression of K14 in 

this model was necessary to promote leader cell formation and immunohistochemical analysis 

revealed that K14 positive cells collectively invade in patient tumor [41]. In contrast, a range of 

K14 expression was detected in cells leading collective invasion in C3-TAg tumor organoids and 

primary tumors. While K14 expressing cells do indeed lead invasion in the C3-TAg model, 

leading cells with low or no K14 expression were also detected. This is consistent with our 

findings in human breast cancer cell lines, where K14 expression was not required for trailblazer 

type invasion or for trailblazer cells to induce cells to opportunistically invade [56]. Moreover, in 

the PyMT model, invasion was led by cells that also expressed p63 and this was required for 

collective invasion [41], in contrast to our data supporting a role of p63 in suppressing the 

trailblazer phenotype [59]. A possible reason of the differential response to the expression of 

K14 and p63 in these two models might be that requirements for invasion depend on tumor 

subtype. Indeed, trailblazer and opportunist populations were found in human TNBC cell lines 

and the C3-TAg model is ER/PR negative and does not express HER2 [132, 135]. In addition, 

the C3-TAg mouse model is considered to represent the human basal breast cancer subtype, 

which is often triple negative [132, 133]. The composition of the ECM adds another factor to the 

cell-specific requirements for invasion. For instance, K14 expressing cells in PyMT organoids as 

well as in primary human tumors invaded in areas enriched in Collagen I [41]. Instead, 

trailblazer cells and C3-TAg organoids invade under multiple ECM compositions. In summary, 

my findings reveal that invasion in the C3-TAg model does not correlate with K14 expression 
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and that additional molecular mechanisms not defined by a basal expression signature must be in 

place to confer a trailblazer phenotype.  

To better understand the requirements for the conversion to a trailblazer EMT state, one 

must also consider the interactions between tumors and their microenvironment during the 

natural progression of cancer disease. This is of major importance, as the dynamic tumor 

microenvironment, co-evolving with malignant cells, enhances the heterogeneity of cancer cell 

populations [13, 26, 27]. Indeed, here I found that organoids derived from primary C3-TAg 

tumors displayed an enhanced invasive phenotype after orthotopic injection relative to the same 

organoids being kept in culture, in agreement with the microenvironment inducing a trailblazer 

EMT in vivo. Stromal cells such as fibroblasts are known to secrete high levels of TGFb, which 

is a factor widely recognized as an inducer of EMT [62, 63]. Therefore, I evaluated if TGFb  

activity can induce a trailblazer EMT state. Inhibition of TGFb  signaling reduced the invasion of 

C3-TAg primary tumor organoids and cells as well as freshly resected tumors plated in 

organotypic culture. This suggested that autocrine TGFb  signaling allowed the invasion of C3-

TAg tumor cells. On the other hand, exogenous TGFb treatment enhanced the extent of invasion 

of C3-TAg organoid and cell line spheroids within 48 hours of exposure. Activation of the TGFb 

pathway induces the expression of EMT transcription factors such as Zeb1/2 and suppresses E-

cadherin to induce a mesenchymal phenotype  [62, 63, 210]. However, the rapid induction of 

invasion by TGFb did not correlate with an increase in canonical EMT genes or a reduction of E-

cadherin, indicating that TGFb promotes the invasion of cells that retain epithelial features. 

These results show that the unique invasive properties of trailblazer cells can be acquired while 

cells retain epithelial traits suggesting that TGFb induces a hybrid trailblazer EMT state. 

Treatment with TGFb have been previously shown to progress cells to a highly mesenchymal 
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EMT state [85]. While longer TGFb exposure did enhanced invasion of C3-TAg cells overtime, 

and Vimentin expression was increased, a stable induction of canonical EMT markers was not 

reached, and E-cadherin expression remained unaltered. Nevertheless, invasion of C3-TAg cells 

was dependent on Zeb1/2. These specific patterns of EMT gene expression and their associated 

phenotypes suggest that TGFb modulates the conversion of cells into distinct EMT states. It is 

possible then that cell-intrinsic properties combined with environmental signals such as TGFb 

activate cell-specific programs that regulate EMT cell identity. 

While different contextual signals can activate cell-specific programs to modulate EMT, 

it has been proposed that the same core transcription factors are found within the spectrum of 

EMT, ranging from the more epithelial to the fully mesenchymal, and are required to induce the 

transcriptional changes that promote different EMT states [32, 93]. In addition to these core 

transcription factors, the various EMT states can be associated with particular epithelial and 

mesenchymal specific transcriptional regulators. For instance, in silico predictions as well as 

functional validation in a model of squamous cells carcinoma (SCC) pointed towards Zeb1 and 

p63 to be involved in promoting an epithelial and early hybrid EMT states, whereas TGFb and 

Smad2 were enriched at the later stages of EMT and responsible for driving the transition from 

EpCAM positive to a highly mesenchymal state [32]. Notably, the transcription factor Zeb1 is a 

common marker between the different invasive states [32]. Interestingly, Zeb1 and Zeb2 are 

required for trailblazer invasion. However, the specific regulatory elements that can modulate the 

transition between EMT states or stabilize a particular cell fate remain undetermined [32, 93]. 

One plausible explanation is the cell plasticity that permits cells of similar genetic nature to 

differentially respond to external cues [97]. It is possible then that cells in more contact with the 

microenvironment, such as those at the tumor-stromal boundaries, respond to signals from 
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fibroblast and changes in ECM composition. Another explanation is the balance between 

mutually inhibitory loops among micro RNAs and transcription factors that suppress the 

expression of each other. For instance, Zeb1 and Zeb2 are critical targets of miR200 family 

members [90, 91]. Conversely, Zeb1 directly inhibits transcription of miR200c genes and all 

miR200 family members are transcriptionally suppressed by Zeb1 and Zeb2 [90, 91]. Thus, 

Zeb1/2 and miR200 regulatory elements, having opposite functions in addition to mutually 

regulating each other’s transcription, are a key example of the mechanisms in place for the 

control of cellular fate. Therefore, functional relationships between distinct regulatory factors by 

way of positive or negative feedback loops together with the combined effects of core and 

transient EMT transcriptional activators come together to dictate cell fate. 

So far, I have presented data pointing to Zeb1/2 as core EMT transcription factors 

required for trailblazer cell invasion, consistent with canonical TGFb activity inducing a 

trailblazer EMT. To elucidate the specific transcriptional regulators of the trailblazer EMT state I 

performed RNAseq analysis on C3-TAg tumor explants and cell lines, followed by functional 

validation of gene candidates that were overexpressed in invasive populations relative to non-

invasive clones. Results of this screening revealed that the transcription factor Fra1 was 

necessary for the induction of a trailblazer EMT. Fra1 is a member of the activating protein 1 

(AP-1) family of transcription factors [142]. The AP-1 transcription factor is a downstream target 

of ERK [138, 142]. Cellular transduction upon ligand binding activation of receptor tyrosine 

kinases such as the epithelial growth factor receptor (EGFR) leads to the phosphorylation of 

ERK1/2 [139-141]. Phosphorylated ERK regulates Fra1 expression and stabilization of its gene 

product, Fra1 [138, 142]. Heterodimerization of Fra1 with members of the Jun family of proteins 

form the transcriptionally active AP-1 complex [142, 145, 192]. Signaling by AP-1 has been 
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associated with various forms of malignancies, including breast cancer [143, 145, 156, 157, 174]. 

Expression of Fra1 in particular has been associated with the triple negative breast cancer 

(TNBC) subtype and its expression correlates with poor patient outcome [145, 163]. Notably, the 

trailblazer EMT state has been found in models of TNBC, as summarized earlier in our 

discussion.  

Confirming the role of Fra1 in the acquisition of a trailblazer character, suppression of 

ERK1/2 activity using the clinically approved MEK1/2 inhibitor Trametinib, restricted 

trailblazer invasion. Inhibition of ERK1/2 reduced Fra1 expression and phosphorylation, and 

while Jun depletion also reduced the invasion of C3-TAg tumor cells, Trametinib treatment did 

not affect Jun expression, indicating that reduction of invasion was dependent on Fra1. Previous 

studies have shown that Fra1 induces EMT by regulating Zeb1/2 and TGFb expression [155]. 

Evidently, the requirement of Zeb1/2 for the induction of a trailblazer EMT could suggest that 

the Fra1-dependent invasion of C3-TAg tumor cells is due to its regulatory activity on Zeb1/2. A 

similar conclusion can be derived by the observation that Fra1 depletion restricted the autocrine 

TGFb-dependent invasion observed in C3-TAg tumor cells. However, silencing of Fra1 in C3-

TAg cells did not affect Zeb1/2 expression. Additionally, Trametinib treated cells did not display 

altered expression of canonical TGFb pathway effector proteins, indicating that ERK1/2 

inhibition suppresses Fra1-dependent invasion without affecting TGFβ activity. This led me to 

conclude that Fra1 controls a signaling program that promotes trailblazer cell invasion in parallel 

to the TGFb pathway induction of trailblazer properties. Importantly, Fra1 depletion restricted 

the exogenous TGFb-enhanced invasion of C3-TAg tumor cells. Thus, this Fra1-dependent 

signaling program is necessary for TGFb to induce a trailblazer EMT state. In support of these 

findings, inhibition of EGFR autocrine signaling suppressed the TGFb-induced trailblazer EMT 
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in C3-TAg tumor cells. Conversely, TGFb pathway inhibition suppressed the invasion that was 

induced after exogenous EGF addition. Moreover, TGFβ1 signaling did not modulate Fra1 

expression in C3-TAg tumor cells. Overall, my findings suggest that TGFb and EGF-ERK1/2-

Fra1 parallel signaling programs modulate distinct regulatory networks that increases collective 

invasion by the conversion to a trailblazer EMT state. 
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CHAPTER IV: OVERVIEW AND FUTURE DIRECTIONS 

 

In summary, the work presented here reveals that parallel signaling programs controlled 

by EGF-Fra1 and TGFb promote the conversion to a trailblazer EMT. Here, the transcription 

factors Zeb1/2 are necessary as core EMT inducing transcriptional regulators, while Fra1 acts as 

priming factor that dictates whether cells undergo a trailblazer EMT. As such, Fra1 provides the 

necessary cell-intrinsic properties while environmental stimuli in the form of secreted TGFb 

activate cell-specific molecular mechanisms to promote a trailblazer EMT.  

TGFb induces EMTs by triggering the expression of core EMT transcription factors 

(EMT-TFs) Snail, Slug, Twist, Zeb1 and Zeb2 [62, 86]. These EMT inducing transcription 

factors repress epithelial polarity genes and cell–cell adhesion proteins such as E-cadherin and 

therefore promote the loss of cellular cohesion that allows cells to migrate as single cells [62, 

210, 211]. In addition, EMT-TFs induce mesenchymal factors that reorganize the cytoskeleton 

and allow protrusion formation, thus conferring cells with the ability to remodel the ECM and 

promote cell migration [62, 86, 97, 204]. Short TGFb exposure of as little as one hour can 

transition cells to a stable EMT state [186]. This brief TGFb treatment was enough to switch 

cells to a permanent E-cadherin-low and Vimentin-high state and acquire a fully mesenchymal 

phenotype independent of TGFb signaling [186]. However, the data presented here indicate that 

a trailblazer state does not necessarily require cells to stably convert to a mesenchymal state or 

independence from TGFb pathway activity. In fact, abrogation of either EGF-ERK1/2-Fra1 or 

TGFb signaling was sufficient to restrict collective invasion, suggesting that both of these 

pathways need to be active in order to sustain a trailblazer EMT state after it is initially induced 
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in cells. Moreover, E-cadherin suppression was not required for trailblazer EMT induction, 

demonstrating that a hybrid EMT can confer cells with trailblazer properties.  

The ERK1/2 and TGFb pathways can integrate, and this crosstalk reinforces downstream 

protein target expression to induce EMT in full mesenchymal populations found in established 

cell lines [166-170]. For example, previous studies have shown that Fra1 regulates Zeb1/2 and 

TGFb expression to induce EMT in established fully mesenchymal mammary epithelial cell lines 

[155]. In contrast, while I observed that Fra1 depletion restricted the autocrine TGFb-induced 

invasion and that Zeb1/2 are required to induce a trailblazer EMT state, suppression of Fra1 

activity did not affect canonical TGFb pathway proteins or Zeb1/2 expression. One possible 

explanation for these differences is that the requirements for invasion might be breast cancer sub-

type dependent [41, 49]. Indeed, these previous studies were performed in models that were 

ER+, while the C3-TAg model is ER/PR negative and does not express HER2 [132, 135]. It is 

also possible that the established cell lines employ signaling networks that are not functional in 

primary tumor cells.  

Expression of Fra1 has been associated with the TNBC subtype and its expression 

correlates with poor TNBC patient prognosis [145, 163]. Thus, the correlation among Fra1, 

TNBC and a trailblazer EMT state indicate that the programs involving Fra1-dependent 

trailblazer EMT might be used as biomarkers of progression specific to TNBC. In fact, our data 

suggests that the future assessment of prognostic factors should include regulatory programs that 

support features of collective invasion. Incorporating the transcriptional activators, EMT state 

modulators and functional interactions between cell subpopulations in the analysis, will better 

define how EMT programs contribute to metastasis. Existing therapeutic strategies could be 

employed to restrict EGF- and TGFb-dependent invasion in breast cancer patients. This is 
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particularly important for TNBC, where no targets for therapies have been identified and where 

cells with a trailblazer cell phenotype might play a major role in progression. However, early 

detection of these particular cell subpopulations must be achieved, so as to abrogate invasion 

before dissemination can occur, as cooperative interactions between cell populations can drive 

invasion and subsequent metastatic spread [56, 96]. Nevertheless, current clinically approved 

drugs may have the potential to limit the rapid invasion of Fra1-expressing cancer cells in 

response to TGFβ exposure [158, 193, 212, 213]. Similarly, inhibition of TGFβR1 activity may 

restrict trailblazer invasion and local dissemination. However, many challenges hinder the 

potential of TGFβ pathway inhibitors as antimetastatic agents. For instance, signaling by TGFβ 

can have an oncogenic role by promoting EMT, cell proliferation, angiogenesis and immune 

evasion during advanced cancer stages and thus contribute to malignant progression in 

established tumors [214, 215]. However, TGFβ can stimulate growth arrest and act as a tumor 

suppressor in the early stages of cancer as well as in normal cells [214, 215]. Moreover, due its 

pleiotropic role in normal biological processes, targeting of the TGFβ pathway in malignant 

disease presents many limitations [214]. For instance, direct inhibition of the TGFβ receptors or 

TGFβ ligands will suppress the TGFβ pathway kinase and cytokine activities, respectively [215-

218], and therefore will inhibit all functions of TGFβ signaling. To overcome this limitation, an 

alternative, more selective approach is to target downstream effectors of the TGFβ pathway such 

as SMAD3 [215, 219]. However, the role of non-SMAD functions of TGFβ in inducing the 

trailblazer EMT remains to be determined [188]. Thus, a comprehensive understanding of TGFβ 

activities in promoting the trailblazer EMT state must be obtained in order to better select the 

therapeutic strategies to be employed in targeting the TGFβ-dependent trailblazer invasion. Some 

toxicities have been observed upon TGFβ pathway inhibition, including cardiovascular toxicities 
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and benign tumors [215-217]. Strategies such as intermittent dosing schedules and patient 

selection have helped improve the unwanted side effects of TGFβ pathway suppression [216]. 

Similarly, stratification based on trailblazer EMT state markers could be employed in selecting 

patient subgroups that will benefit from TGFβ as well as EGFR blockade, in order to maximize 

their clinical benefits over adverse effects. This, in combination with additional biomarkers such 

as pre-treatment levels of TGFβ or expression of TGFβ-associated genes, might help to further 

strengthen the selection process of patients that might benefit from anti-TGFβ therapy.  

By defining the invasive phenotypes that are induced in Fra1 expressing cells in response 

to TGFb, and their associated patterns of EMT gene expression, I have started to uncover the 

potential functional contributions of diverse EMT states in metastatic progression. TGFb-

dependent activation of a hybrid trailblazer EMT state confers intrinsic invasive properties to 

cells that retain epithelial characteristics. Importantly, it has been shown that sustaining an 

epithelial character is required for efficient colonization and formation of metastases [92, 99-

101]. This means that not only can hybrid trailblazer EMT cells lead the collective invasion of 

proliferative siblings, but they also have the potential to colonize distant sites themselves. 

Moreover, the rapid induction of a trailblazer EMT by TGFb could possibly accelerate the 

progression to metastasis. Therefore, in addition to defining the nature of these cellular 

interactions, future strategies should address the specific cell-intrinsic molecular properties that 

prime cells to undergo a trailblazer EMT in response extrinsic factors.  
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